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CHAPTER 1. INTRODUCTION 

Axion Integrated Studio (AxIS ) Navigator is a multipurpose software for data acquisition and analysis with 

the Maestro Pro and Maestro Edge microelectrode array (MEA) systems. This manual provides a basic 

overview of AxIS Navigator and instructions for data acquisition, stimulation, and analysis. For step-by-step 

instructions for data acquisition and analysis, see Sections 3.3 and 9.5. For operation of the Maestro Pro, 

Maestro Edge, Lumos, or APEX, refer to their respective manuals. For cell culturing protocols, application 

notes, posters, and publications, visit www.axionbiosystems.com/resources.  

Throughout this manual, the term “Maestro” will be used to refer to both the Maestro Pro and Maestro Edge 

systems, since the majority of functionality in AxIS Navigator is shared by both platforms. Images in this 

document are for illustrative purposes and represent a variety of different plate types available for use with the 

Maestro Pro system (Section 2.1.1).  

Additional analysis tools are available to supplement AxIS Navigator and provide application-specific 

analysis support (see Appendix A). Tools are available for download through the ShareFile system. Contact 

support@axionbio.com for ShareFile access.  

1.1. NEW AXIS NAVIGATOR FEATURES 

AxIS Navigator 3.10 includes a variety of improvements in an effort to continually improve the usability of the 

Maestro systems. 

1.2. TECHNICAL SUPPORT  

For additional AxIS Navigator support and assistance, please contact your authorized Axion BioSystems 

distributor or Axion BioSystems directly.  

Axion BioSystems contact information: 

Phone: 1 (404) 477-2557 

Email: support@axionbio.com    

Please have the following information available when requesting technical assistance:  

• Description of the problem 

• What was happening at the time of the error 

• What you have tried so far to solve the problem 

• A copy of Axion Support Bundle (generated from the Help menu) 

• Screen shots of any errors   

mailto:support@axionbio.com
mailto:support@axionbio.com
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CHAPTER 2. AXIS NAVIGATOR OVERVIEW 

The AxIS Navigator user interface is designed to provide easy access to all experimental controls. The top 

Menu bar controls file loading, saving, and display. Most of the settings for data acquisition, analysis, and 

display are found in the left panel. The left panel contains the current plate information (Active Plate), the File 

Play and Display controls, and the data stream and data processors under Streams. The Control Bar along the 

bottom contains panels that support various analysis functions and data visualization. The active window 

displays the window selected from the Control Bar below. The Status Bar at the bottom of the active window 

displays file status, play and record times, and timestamp notes.   

 

2.1. MENU BAR 

The Menu bar has four options:  

Menu Option Description 

File Open Recording(s)… Loads one or more .raw files into the Streams pane. 

New Batch Process… Opens the batch processing dialog. See Section 9.6. 

Open Stim Waveform 
Loads a stimulation waveform file (.sswf) into the Stimulation 

Studio module. See Chapter 4. 

Save Stim Waveform 
Saves the current stimulation waveform from Stimulation Studio. 

See Chapter 4. 

Exit Closes AxIS Navigator. 
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Tools 

Maestros 

Allows users to Locate and Select a specific Maestro when more 

than one Maestro is connected to the same computer. Selecting 

Locate will cause the power button for the selected system to 

flash through a rainbow of colors. Clicking Select will choose that 

Maestro system for data collection in the software. Only Maestro 

Edge/Pro systems will be available in the list. 

Enable Remote Control Allows AxIS Navigator to receive commands from other Axion 

tools. 

Motors → Ignore Safety 

Limits… 

Allows direct control over the motors in the door and plate holder 

and bypasses safety controls. Only select this option with direct 

guidance from Axion BioSystems. Warning: Ignoring safety limits 
may result in mechanical damage or improper operation. 

Motors → Recalibrate 

Motors… 

Recalibrates Maestro motors in the door and plate holder. Only 

select this option with direct guidance from Axion BioSystems. 

Graphics → Disable 

Hardware Acceleration 

Allows user to Disable Hardware Acceleration for AxIS 
Navigator. Users should contact support@axionbio.com before 

selecting this option. 

Reset AxIS Navigator Restores AxIS Navigator to default settings. Removes all loaded 

files and configurations. 

Accelerate Playback When replaying a previously recorded .raw file, Accelerate 

Playback plays the file back faster than real time. 

Accelerate Recording When recording new analysis files from a previously recorded 

.raw file, Accelerate Recording plays the file back and 

performs analysis faster than real time. 

Help Restore Firmware Reinstalls or updates the firmware on the Maestro (and Lumos if 

attached) to ensure compatibility with AxIS Navigator. This 

should be done after every software upgrade. 

User Guide Opens the AxIS Navigator user guide. 

Create Support Bundle Creates an error log report for email to Axion Support team. If 

multiple Maestros are connected, users can select all or a 

specific Maestro system to generate an error log report. 

About Displays AxIS Navigator version number and information. 

 

2.1.1. Software Module Activation 

The Manage Modules... option under the Help menu opens a window that displays all of the software 

modules available, each identified with a name, icon, and active status. Active software modules will be 

shown in blue, while inactive modules are grayed out.  This option is only enabled if the Maestro is connected 

to AxIS Navigator (see Section 3.1). 

mailto:support@axionbio.com
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Available software modules are listed below: 

 

Software Module Description Axion System Software  

Neural Measure electrical network behavior of 

neurons, including: activity, synchrony, and 

network oscillations, label-free. 

Maestro Pro 

Maestro Edge 

AxIS Navigator 

Cardiac Record the 4 key measures of cardiac 

performance: action potential, field potential, 

propagation, and contractility. 

Maestro Pro 

Maestro Edge 

AxIS Navigator 

MEA Automation An application programming interface (API) 

that can be used for interfacing with liquid 

handling platforms or other systems to 

automate MEA experiments. 

Maestro Pro 

Maestro Edge 

AxIS Navigator 

MEA Viability Use impedance technology on MEA plates to 

track cell viability and coverage in each well 

from the same microelectrodes used for 

functional activity measurements.  

Maestro Pro 

Maestro Edge 

AxIS Navigator 

Impedance Track cell proliferation, viability, barrier 

function, immune cell-mediated killing, viral 

cytopathic effects, and more. 

Maestro Pro 

Maestro Edge 

Maestro Z 

Maestro ZHT 

AxIS Z 

GxP Impedance Achieve FDA 21 CFR Part 11 compliance in 

GMP/GLP labs with this version of the 

Impedance Software Module. 

Maestro Pro 

Maestro Edge 

Maestro Z 

Maestro ZHT 

AxIS Z 

Impedance 

Automation 

An application programming interface (API) 

that can be used for interfacing with liquid 

handling platforms or other systems to 

automate impedance experiments. 

Maestro Pro 

Maestro Edge 

Maestro Z 

Maestro ZHT 

AxIS Z 
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To request a module activation key(s) for an inactive software module(s):  

 

1. Navigate to the Manage Modules window from the Help menu in AxIS Navigator. 

2. Click Request Module… 

3. If the Maestro computer has an active internet connection, the software will open Axion’s 

licensing web page and auto-fill Device ID and Serial Number fields. 

3.2. If the Maestro computer is offline, the Requested Modules window will open. Select the 

box(es) next to the requested software modules.  

Note: Software modules already active or requested will be checked and disabled. 

3.3. Click Save… . The software will save the Device ID and Serial Number to a text file 

3.4. Email the text file to support@axionbio.com.  

 

 

To activate a software module:  

 

1. Navigate to the Manage Modules window in the Help menu in AxIS Navigator. 

2. Click Activate Module… 

3. Navigate to the folder with module activation key (.xml file).  

Note: Axion Biosystems will send users module activation keys for purchased software modules. 

4. Select the module activation key and click Open. 

5. The module activation key will be stored on the Maestro system and the corresponding software 

module will be displayed as active in the Manage Modules window. 

https://www.axionbiosystems.com/request-a-quote
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2.2. ACTIVE PLATE 

The Active Plate displays the current plate configuration. The 

plate configuration determines how electrodes are mapped to the 

wells and is critical for proper analysis. The Active Plate interface 

can be used to select wells or electrodes for recording and store 

information about well contents.  

The Active Plate will automatically be set to the correct plate type 

when a plate is docked in a Maestro MEA system. The drop-

down menu will populate with new plate types as new plates are 

used. To view all available plate types, select View → Show All 

Plate Types. 

Maestro MEA plate types include: 

Plate Type System Compatibility Part number 

Smart Plate – Pro/Edge Maestro Pro and Maestro Edge N/A 

BioCircuit MEA 24 Maestro Pro and Maestro Edge M384-BIO-24 

BioCircuit MEA 48 Maestro Pro M768-BIO-48 

BioCircuit MEA 96 Maestro Pro M768-BIO-96 

CytoView MEA 6 Maestro Pro and Maestro Edge 
M384-tMEA-6B 

M384-tMEA-6W 

CytoView MEA 24 Maestro Pro and Maestro Edge M384-tMEA-24W 

CytoView MEA 48 Maestro Pro 
M768-tMEA-48B 

M768-tMEA-48W 

CytoView MEA 96 Maestro Pro 
M768-tMEA-96B 

M768-tMEA-96W 

Lumos MEA 24 Maestro Pro and Maestro Edge M384-tMEA-24OPT 

Lumos MEA 48 Maestro Pro M768-tMEA-48OPT 

Lumos MEA 96 Maestro Pro M768-tMEA-96OPT 

NETRI DuaLink MEA – Pro/Edge Maestro Pro and Maestro Edge 
Product sold by NETRI, contact 

NETRI for more information 

NETRI DuaLink Shift MEA – 

Pro/Edge 
Maestro Pro and Maestro Edge 

Product sold by NETRI, contact 

NETRI for more information 

NETRI TriaLink MEA – Pro/Edge Maestro Pro and Maestro Edge 
Product sold by NETRI, contact 

NETRI for more information 

Note: Contractility and Neural Broadband require CytoView or Lumos MEA plates. 
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Double-click the Active Plate to open the Plate Map Editor. The Plate Map Editor is used to select wells or 

electrodes for recording and store information about well contents. The editor has a representation of the plate 

where each well consists of a square of circle electrodes. The right section contains the well information of the 

currently selected well(s), including the Treatment, Concentration, Well Color, Notes, and whether the well is 

on or off for recording. Import and Export buttons allow the user to load previously created plate maps or 

export the current map for future use. The Lock icon prevents the information from being edited. When editing 

the plate map associated with the live Maestro stream, the Plate Map Editor is always unlocked. For a 

previously recorded raw file, click the lock on the lower left to make changes. Information entered in the editor 

is stored with the recording and used in data analysis.  

Note: All changes to the plate map are automatically saved in the previously recorded file.  

 

2.2.1. Enabling or Disabling Wells and Electrodes 

Once selected, wells can be turned on or off with the toggle switch under Well Information. Disabled wells 

appear black in the Plate Map Editor. An electrode may be turned on or off by double-clicking on it. Disabled 

electrodes are connected to ground and appear gray in the Plate Map Editor. Turning off a well or electrode 

will prevent it from being recorded or analyzed, reducing the file size.   

2.2.2. Entering Well Information 

Click on a well to select it. Multiple wells can be selected by clicking on the column or row label to highlight 

the column or row, respectively; clicking the * in the upper left corner to highlight the entire plate; holding the 

Selected Well 

Unlock to Edit 

Treatment Information 

Well On/Off Status Well Color 

Electrode Off 
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Ctrl key and clicking on the desired wells; selecting two wells while holding the Shift key to select all of the 

wells between them; or by click-and-drag selecting wells in a region. 

Note: A plate map can only be edited when it is unlocked using the Lock button. 

To assign well information: 

1. Select the desired well(s). 

2. Type a name in the Treatment field and press enter or click on the green check mark that appears. Do 

not use commas in the Treatment name. Use the control checkbox to indicate if this well is a control 

well.  

3. Type the concentration in the Concentration field, including units (a space between the units and 

concentration is optional), and press enter or click on the green check mark that appears. Do not use 

commas, dashes, or special characters in the Concentration field. If concentration is not applicable, 

leave the field blank.  

Note: AxIS Navigator will convert “uM” or “um” to “µM” or “µm”, respectively.  

4. Enter any additional information in the Notes field. 

Note: When selecting multiple wells to edit, each field operates independently. If only the Treatment is 

entered, Concentration information will remain unchanged for those wells, and vice versa. If any field is 

empty, it will not be cleared; instead it will remain unchanged. 

To copy well information between wells: 

1. Select the desired well(s). 

2. Press Ctrl-C or right-click → Copy Well.  

3. Select the destination well(s) 

4. Press Ctrl-V or right-click → Paste Well 

Note: Multiple wells can be copied and pasted at the same time, as long as the selected wells have the 

same shape (e.g. copy/pasting a full row to a different row). 

To clear well information from wells: 

1. Select the desired well(s). 

2. Click Clear Well.  

2.2.3. Setting Well Color 

To set well color manually:  

1. Select the well(s). 

2. Click on Well Color in the upper right corner of Well Information and choose a color.  

To set well color automatically: 

1. Right-click on any well. 
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2. Select Auto Color. Each treatment will receive a different hue and each concentration of a treatment 

will receive a different shade. 

To change the hue of a treatment group: 

1. Right-click on any well. 

2. Select the treatment group from the menu. 

3. Select Set Hue and choose the hue from the options available. Each concentration in that treatment 

group will be receive a different shade of the selected hue.  

 

 

2.2.4. Importing and Exporting Plate Maps 

Plate maps may be imported or exported using the Import and Export buttons in the Plate Map Editor. Plate 

maps can also be copied and pasted to and from Microsoft Excel (Section 2.2.5). 

To export a plate map using the export button:  

1. Click the Export button in the Plate Map Editor. 

2. Enter a name for the plate map and click Save. The file will be saved with a .platemap extension. 

To import a plate map using the import button:  

1. Click the Import button in the Plate Map Editor. 

2. Select the desired .platemap, .raw, or .spk file and click Open. 

Right-click Menu 

Import/Export Plate Map 

Clear Well 
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Note: Selecting a previous recording (.raw file) or Spike file (.spk) will load its plate map into the 

current file. 

2.2.5. Creating a Plate Map in Excel 

AxIS Navigator recognizes two text formats which may be imported from or exported to Microsoft Excel.  

In format 1, each row corresponds to a different piece of plate map data and each column represents a well. 

The columns are labeled with the well ID where well A1 is row A, column 1. The plate map data includes: 

 

Option Description 

Active Whether or not the well is enabled (TRUE or FALSE) 

Well Coloring Hexadecimal color code for the Well Color 

Control Whether or not Control field is selected (TRUE or FALSE) 

Treatment String containing the Treatment field 

Concentration String containing the Concentration field 

Additional Information String containing the Notes field 

 

To copy the plate map in AxIS Navigator and paste to Excel in format 1: 

1. Right-click on one or more wells in the Plate Map Editor. 

2. Select Copy Wells. 

3. Click on any cell in Excel and press Ctrl+V. 

To copy the plate map in Excel and paste in AxIS Navigator: 

1. Highlight the desired wells in Excel, including the Well Number. 

2. Press Ctrl+C. 

3. Select the corresponding wells in the Plate Map Editor. 

4. Right-click on one of the wells and select Paste to Well(s). 

In format 2, each cell represents a well on the plate and contains information in the format of “Treatment 

[Concentration]”. The color of the cell corresponds to the Well Color. Rows are labeled A, B, C… and 

columns are labeled 1, 2, 3…. 
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To copy the plate map in AxIS Navigator and paste to Excel in format 2: 

1. Right-click on any well in the Plate Map Editor. 

2. Select Copy Plate Mapping. 

3. Click on any cell in Excel and press Ctrl+V. 

To copy the plate map in Excel and paste in AxIS Navigator: 

1. Highlight the entire plate map in Excel, including the row and column headers. 

2. Press Ctrl+C. 

3. Select all wells in the Plate Map Editor. 

4. Right-click on one of the wells and select Paste to Well(s). 

2.3. STREAMS 

The Streams pane displays all currently loaded data streams. A data stream contains the live or recorded 

continuous voltage data from a Maestro and all associated data processors. See Section 2.3.1 for more 

information on data processors. A stream is organized in a hierarchy beginning with the continuous voltage 

data and then passing through the data processors in sequence. Combining processors into different 

configurations provides customizable stream flows for different applications. Axion provides preset processor 

configurations for specific cardiac and neural applications (Sections 3.2.2 and 9.1). Customized 

configurations can be manually constructed by placing individual data processors on the stream (Section 

2.3.1) and saved or loaded by right-clicking on the stream. 

The first stream represents the Maestro continuous voltage data. When the Maestro is connected, the stream 

will be called Maestro Pro (“Name of Maestro Pro”) or Maestro Edge (“Name of Maestro Edge”), 

depending on which Maestro MEA system is used. If no Maestro is connected, the stream will be inactive and 

say “No Device Connected”. The default Maestro name is “Maestro-XXX”, where XXX is the last 3 digits of the 

Maestro serial number. 

Only active streams may be viewed or analyzed in AxIS Navigator and only one stream may be active at a 

time. The active stream is indicated by a colored square and bold black text. Inactive streams have gray 

squares and gray text. 

To activate a data stream: 

1. Right-click on the continuous voltage data name. 

2. Select Select for Play/Rec.  
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To load a new data stream: 

1. Click File → Open Recording(s)…. 

2. Navigate to the desired recording (.raw file) and click Open. 

To remove a data stream or batch process: 

1. Right-click on the continuous voltage data name. 

2. Select Remove.  

To remove all data streams in the Streams pane: 

1. Right-click on white space in the Streams pane. 

2. Select Remove All Files.  

2.3.1. Data Processors 

Data processors are added to data streams to alter or analyze the data. They all require input from a 

continuous data stream or another data processor, and output an altered continuous data stream, metric(s), 

and/or an output file. Information from some data processors is visualized using the various AxIS Navigator 

pane. Some data processors and settings are disabled during live data streams and some may not be 

modified unless streaming has stopped.  

Preset configurations containing combinations of data processors recommended for most applications are 

provided in AxIS Navigator. See Sections 3.2.2 and 9.1 for more information about these recommended 

default stream configurations. 

To add a data processor: 

1. Right-click on the stream in the Streams pane. 

2. Select Add Processing and select the desired data processor.  

Note: Some data processors are dependent on others and may only be added below the requisite 

processor.  

3. Enter the desired settings and click OK. 

To remove a data processor: 

1. Right-click on the processor in the Streams pane. 

2. Select Remove. 

Note: Removing a data processor will remove all processors below it on the same continuous data 

stream.  

To access the settings of a data processor: 

1. Right-click on the processor in the Streams pane. 

2. Select Settings. 
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-- Or -- 

1. Double-click on the processor in the Streams pane. 

To change the visibility of a data processor: 

1. Right-click on the processor’s stream in the Streams pane. 

2. Select Plot → Show. If enabled, the processor will show in dependent AxIS Navigator panels.  

To change the color of a data processor: 

1. Right-click on the processor in the Streams pane. 

2. Select Plot → Change Trace Color. 

3. Select the desired color and click Enter.  

2.3.2. Digital Filter 

The Digital Filter processor applies a digital Butterworth bandpass filter to any continuous voltage data stream 

to further reduce noise. This filter is applied on top of hardware-based filters selected in the Maestro Pro/Edge 

Settings (Section 3.2.1) during a recording. The output of this data processor is a filtered continuous voltage 

data stream (.raw file), and data processors placed below the Digital Filter will act on the filtered data stream.    

 

The digital filter has a High Pass Filter (the frequency components of the signal must be above the cutoff 

frequency to pass through) and a Low Pass Filter (the frequency components of the signal must be below the 

cutoff frequency to pass through). To adjust either, enter the new value into the respective Cutoff Frequency 

text field.  

Note: The Digital Filter operates on voltage data, as is recorded in Neural configurations, Cardiac Field 

Potentials, and Cardiac LEAP configurations. It should not be applied to cardiac contractility signals. 
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2.3.3. Artifact Eliminator 

The Artifact Eliminator removes artifact in raw signals resulting from electrical stimulation. The removal includes 

blanking of the large initial impulse as well as removal of residual artifact based on the similarity of its profile 

across electrodes. The output of this data processor is a continuous data stream (.raw file) with the artifact 

removed. Data processors placed below the Artifact Eliminator will act on that output.    

2.3.4. Stimulation Inspector 

The Stimulation Inspector provides a close look at voltage data near an Electrical or Optical Stimulation Tag 

to evaluate artifact elimination and cellular response to the stimulation. The Stimulation Inspector plots the 

continuous voltage data just before and after an Electrical or Optical Stimulation Tag in the Spike Plots panel. 

Note the Stimulation Inspector is for visualization only and does not produce an output file.  

 

While using the Stimulation Inspector data processor, the Electrical or Optical Stimulation Tag will appear as 

a triangle and vertical line at time zero on the spike plot. The time displayed before and after the tag may be 

changed in the Stimulation Inspector settings by the Pre-Tag and Post-Tag fields, respectively. The waveform 

plots overlay with the brightest trace representing the most recently detected stimulation event. 

Note: The Stimulation Inspector displays voltage data, therefore is useful for evaluating capture in Neural 

Evoked configurations as well as Cardiac Field Potentials Paced and Cardiac LEAP Paced configurations. It 

should not be applied to cardiac contractility signals. 

2.3.5. Spike Detector 

The Spike Detector detects threshold crossings in the continuous data stream. These crossings are referred to 

as “spikes” and are plotted in the Spike Plots panel as spike waveform and raster plots. The Spike Detector 

processor is the base processor for neural data visualization and analysis. It identifies the spike timing and 

location and is the source for the Spike Plots and Activity Map panels. Burst Detector data processors (Section 

2.3.6) may only be placed below a Spike Detector. The Spike Detector produces several outputs including 
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AxIS Spike (.spk), Spike Count (.csv), and Spike List (.csv) files. See Section 9.2 for more information about 

these output formats. 

 

Setting a proper detection threshold is crucial for accurate neural data analysis. Lower thresholds increase the 

incidence of false-positives (small noise events misidentified as spikes); higher thresholds may not detect 

smaller amplitude action potentials. Axion recommends an adaptive threshold of 6 x standard deviations to 

minimize both false-positives and missed detections. 

The Spike Detector has four possible threshold detection methods selected by the Methods drop-down menu:  

1. Adaptive Threshold (Recommended): Threshold is set on a per electrode basis, as a multiple of the 

noise of the continuous data, each electrode threshold is specific to that electrode. The standard 

deviation multiple can be set in the Threshold field. Detect Only Crossings requires the signal to return 

below threshold before detecting an additional spike. The spike time is marked at the maximum slope 

of the spike voltage waveform.  

2. Static Threshold: Threshold is set on a plate-wide basis, all electrode thresholds are the same. Spikes 

are detected as any event greater than the value defined in the Threshold field. Detect Only Crossings 

requires the signal to return below threshold before detecting an additional spike. The spike time is 

marked at the maximum slope of the spike voltage waveform. 

3. Peak Detection Adaptive Threshold: Functions the same as the Adaptive Threshold above, but the 

spike time is marked at the peak of the spike voltage waveform, as defined by the Peak Detection 

drop-down menu.  

4. Peak Detection Static Threshold: Functions the same as the Static Threshold above, but the spike time 

is marked at the peak of the spike voltage waveform, as defined by the Peak Detection drop-down 

menu. 

 

The Peak Detection drop-down menu options are: 

Option Description 
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Positive Inflection Marks the first peak with a positive voltage 

Negative Inflection Marks the first peak with a negative voltage 

First Peak Marks the first peak regardless of polarity (positive or negative) 

Maximum Amplitude Marks the peak with the largest amplitude 

 

The Durations dialog box sets the display in the Spike Plots panel. Use the Pre-Spike and Post-Spike fields to 

specify how much time before and after each spike crossing will be displayed on the spike waveform plot and 

saved in an AxIS Spike file. The spike time, determined by the Method drop-down menu, is plotted as zero. 

The Coincident Events dialog box removes coincident artifacts from analysis results. Coincident artifacts are 

artificial spikes detected on multiple electrodes at the same time. They may occur during an electrical stimulus 

or due to environmental interference like bumping the system or touching the media in a well. AxIS Navigator 

identifies a coincident artifact as spikes occurring on a minimum number of electrodes (Occurrence Threshold) 

over a maximum length of time (Event Window). 

The Coincident Event Removal drop-down menu specifies how AxIS Navigator will search for coincident 

spikes across the plate. Select from: 

1. None: No search will be performed. 

2. Well: Search will look for coincidence across electrodes in a well. 

3. Plate: Search will look for coincidence across electrodes in any well on the plate.   

4. Chip: Search will look for coincidence across electrodes that share a hardware circuitry connection.  

For example, if Coincident Event Removal is set to Well with Occurrence Threshold equal to 4 electrodes and 

Event Window equal to 80 µs, spikes that occur on at least 4 electrodes in the same well within 80 µs of each 

other will be ignored. 

The Spike Counting box sets the bin time for counting spikes as defined by the Interval field. The bin time is 

used by the Activity Map panel and the Spike Count files. 

2.3.6. Burst Detector 

The Burst Detector is a neural data processor that analyzes spike timing patterns to identify bursts on individual 

electrodes (single-electrode bursts) and across multiple electrodes (network bursts). See Section 11.3 for more 

information about neural bursting. Because it requires spike data, a Burst Detector can only be placed after a 

Spike Detector. A Neural Statistics Compiler data processor (Section 2.3.1111) may only be placed below a 

Burst Detector. The Burst Detector has two outputs: Electrode Burst List (.csv) and Network Burst List (.csv). 

Burst Detector results are displayed in the raster plot in the Spike Plots panel. Spikes belonging to single-

electrode bursts are plotted on the raster in the same color as the Burst Detector plot color. Network bursts are 

indicated by a box of the contrasting color.  
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The Burst Detector has two single-electrode burst detection methods, selectable in the Single Electrode Bursts 

drop-down menu:  

1. Inter-Spike Interval (ISI) Threshold: An electrode burst is defined as at least N spikes on an electrode, 

each separated by an inter-spike interval (ISI) of no more than T seconds. The method is adapted 

from Chiappalone et al., 2005. The minimum number of spikes and maximum time between each 

spike are set using the Minimum Number of Spikes and Maximum Inter-Spike Interval fields, 

respectively.   

2. Poisson Surprise: This algorithm assumes the neurons are firing according to a Poisson distribution. A 

collection of spikes is compared to the probability that this collection of spikes would occur by 

chance. If the collection of spikes exceeds the “surprise” threshold, then it is considered an electrode 

burst. The Minimum Surprise field determines how sensitive burst detection is. A higher threshold 

makes the burst detector less likely to detect an electrode burst, while a lower threshold is more lenient 

and more likely to accept a less “surprising” collection of spikes as burst. The method is adapted from 

Legéndy & Salcman, 1985. In this way, the algorithm is adaptive to the mean firing rate on each 

electrode, computed dynamically to enable real-time detection and visualization of bursts. 

Use the checkbox in the Network Bursts section to Enable Network Burst Detection. The network burst 

algorithm relies on defining a network burst as a collection of N spikes detected across the entire well (not 

limited to a single electrode), each separated by an inter-spike interval of no more than T seconds. In addition 

to the above criteria, a minimum number of electrodes (E) must contribute to the network burst. In the Network 

Bursts box, set N spikes with Minimum Number of Spikes, T seconds with Maximum Inter-Spike Interval, and E 

electrodes as a percentage of the total electrodes with Minimum Participating Electrodes (%).  

The Detection Window field in the Mean Firing Rate Estimation box sets the duration of the sliding window 

used to calculate the mean firing rate for Poisson Surprise burst detection. 
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The Window Size field in the Synchrony Parameters box is the window of time around zero phase-lag used to 

compute the area under the cross-correlation and area under the normalized cross-correlation synchrony 

metrics provided by AxIS Navigator. See Section 11.3 for further explanation of synchrony. 

2.3.7. Broadband Processor 

The Broadband Processor is a specialized node which is used to divide broadband neural signals collected in 

Neural Broadband mode into two data streams:  

1. High frequency (200 Hz - 5000 Hz) Spike Trace 

2. Low frequency (1 Hz – 50 Hz) Local Field Potential (LFP Trace) which is downsampled to a rate of 

100 samples/sec 

    

The Broadband Processor can only be attached to streams collected in Neural Broadband mode. This data 

processor outputs 2 filtered continuous voltage data streams which will be saved to the same .raw file.  

The only data processor which may be attached to the Broadband Processor is the Neural Event Detector, 

which is designed to operate on the dual voltage streams.  

2.3.8. Neural Event Detector 

The Neural Event Detector, only available for attachment to the Broadband Processor, combines the 

functionality of the Spike Detector, the Burst Detector, and an LFP Detector. The Spike Detector and Burst 

Detector within the Neural Event Detector operate on the high frequency Spike Trace within the Broadband 

Processor and contains the same settings as the standalone Spike Detector and standalone Burst Detector.  

Like the standalone Spike Detector and Burst Detector, the Neural Event Detector can output Spike Count 

(.csv), Spike List (.csv), Electrode Burst List (.csv), and Network Burst List (.csv) files. Unlike the standalone 

detectors, it is also capable of outputting LFP Event List (.csv) and AxIS Event (.spk) files. 
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The LFP Detector within the Neural Event Detector detects threshold crossings of the low frequency LFP Trace 

from the Broadband Processor it is attached to. These slow, discrete voltage deflections are referred to as LFPs 

and are plotted in the LFP Plots panel. The LFP Detector has settings similar to the Spike Detector.  

Voltage Threshold: Threshold is set on a plate-wide basis, all electrode thresholds are the same. LFPs are 

detected as any event greater than the value defined in the Threshold field. Detect Only Crossings requires the 

signal to return below threshold before detecting an additional LFP. The LFP time is marked at the time of initial 

threshold crossing. 

The Durations dialog box sets the display in the LFP Plots panel. Use the Pre-LFP and Post-LFP fields to specify 

how much time before and after each LFP crossing will be displayed on the LFP waveform plot and saved in an 

AxIS Event (.spk) file alongside spike times. The time of initial threshold crossing is plotted as zero. 

Setting a proper detection threshold and duration is crucial for accurate LFP collection. Lower thresholds 

increase the incidence of false-positives (drift or noise events misidentified as LFPs); higher thresholds may not 

detect smaller amplitude LFPs. Depending on cell type or maturity, LFPs may have larger or smaller voltage 

deflections and longer or shorter durations. These settings will require tuning on an application specific basis.  

2.3.9. Cardiac Beat Detector 

The Cardiac Beat Detector processor detects threshold crossings in the continuous data stream to identify 

“beats” and calculates associated cardiac endpoints. The beats are displayed in the Cardiac Beats Plots 

panel as cardiac waveform, conduction, and beat period plots. The Cardiac Beat Detector is the base 

processor for cardiac data visualization and analysis. It identifies the beat timing, propagation, amplitude, 

and duration and is used as a source for the Cardiac Beat Plots and Activity Map panels. The Cardiac 

Statistics Compiler data processor (Section 2.3.1010) may only be placed below a Cardiac Beat Detector. 

The Cardiac Beat Detector has two outputs: Electrode Beat List (.csv) and Well Beat List (.csv). See Chapter 

1010 for more information about cardiac analysis endpoints. 
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The Cardiac Beat Detector settings are divided into three sections: Beat Detection Parameters, Conduction 

Parameters, and Display.  

Setting a proper detection threshold is crucial for accurate cardiac data analysis. Beat detection is controlled 

by the following fields:   

1. Detection Threshold: Sets the threshold for detecting a beat for field potential signals. When the 

continuous voltage data exceeds this threshold, the algorithm begins searching for a beat that meets 

the Min Beat Period and Max Beat Period parameters. If a beat is identified, the beat time is marked 

as the point of maximum slope of the depolarization spike. The threshold should be lower than the 

initial depolarization spike amplitude and higher than any other feature of the cardiac waveform 

(300-600 µV is recommended). 

Note: A separate algorithm is used to detect beats for LEAP signals acquired using Cardiac: LEAP and 

contractility signals acquired using Cardiac: Contractility Acquisition Settings. Changing the Detection 

Threshold will not influence the detection of LEAP or contractility beats. 

2. Min Beat Period: The minimum time between two threshold crossings to be considered a beat. 

3. Max Beat Period: The maximum time between two threshold crossings to be considered a beat. 

4. LEAP Detection: Sets the sensitivity for detecting LEAP signals. If small LEAP signals are not detected 

using the Standard algorithm, select High Sensitivity from the drop-down menu.  
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Note: High Sensitivity LEAP detection can label signals as LEAP that are not true LEAP signals. Use 

with caution. 

For field potential signals, Field Potential Duration (FPD) is calculated as the time between the depolarization 

and repolarization, noted by the beat time and the repolarization peak or T-wave, respectively. Due to 

processor constraints, FPD detection is disabled during data acquisition. To identify the T-wave, there are three 

methods selectable in the FPD Method drop-down menu: 

1. Polynomial Regression (Recommended): Performs a polynomial regression to identify a peak or 

trough between two time points. The search window starts at the Post Spike Detection Holdoff, the 

time after the current depolarization spike. The window ends with either the Pre Spike Detection 

Holdoff, the time before the next depolarization spike, or the Max Post Search Duration, a fixed 

maximum time after the current depolarization spike. The T-wave Detection Feature drop-down 

determines whether the regression searches for a peak (Max), trough (Min), or either (Auto 

(Max/Min)). 

2. Inflection Search: Segments the search window to identify the region containing the T-wave and then 

performs a polynomial regression on that segment to determine the exact location. To identify the T-

wave segment, the algorithm searches for a region that crosses a threshold X times the noise as set by 

Detection Threshold. After identifying the segment, a polynomial regression is performed on a 

window of size Regression Window Size. The search window starts with the Post Spike Detection 

Holdoff, the time after the current depolarization spike, and ends with the Pre Spike Detection 

Holdoff, the time before the next depolarization spike. The number of segments is set by the Beat 

Segmentation field. The T-wave Detection Feature drop-down determines whether the regression 

searches for a peak (Max), trough (Min), either (Auto (Max/Min)), or the maximum slope of the 

waveform (dV/dt).  

3. Zero Crossing: Performs a polynomial regression to identify a zero crossing between two time points. 

The search window starts with the Post Spike Detection Holdoff, the time after the current 

depolarization spike. The window ends with either the Pre Spike Detection Holdoff, the time before 

the next depolarization spike, or the Max Post Search Duration, a fixed maximum time after the 

current depolarization spike. The first zero crossing of this regression is chosen as the T-wave location. 

 

Averaging multiple cardiac waveforms across beats can reduce noise and increase T-wave resolution and 

recognition by AxIS Navigator. The cardiac waveform displayed in the Cardiac Beat Plots panel is the 

average of the current beat and the previous N-1 beats as set by the Running Average Beat Count. Use the 

averaged beat for FPD detection by enabling the Use for FPD Detection checkbox.  

The Conduction Parameters section identifies well beats, also called synchronized beats. A synchronized beat 

is a depolarization spike detected on a minimum number of electrodes within a well in a certain time window. 

The synchronized beat time is marked as the beat time of the first participating electrode. The minimum 

percentage of participating electrodes is set by Min Active Electrodes. The time frame is set by Max 

Propagation Delay. Synchronized beats are displayed on the Conduction plot in the Cardiac Beat Plots panel.  
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The Display section controls the data visualization in the Cardiac Beat Plots panel. It has the following settings: 

1. Display Start: The amount of time displayed before the depolarization spike. 

2. Display End: The amount of time displayed after the depolarization spike. 

3. Averaged Beats checkbox: If enabled, displays the averaged beat waveform plot instead of the 

instantaneous beat waveform plot for each electrode. The number of beats used to create the 

average is specified in the Running Average Beat Count field in Beat Detection Parameters. 

4. Synchronized Beats Only checkbox: If enabled, displays only beats that qualify as synchronized 

beats. 

5. Scale Beat Brightness checkbox: If enabled, beats with large amplitude depolarization spikes are 

displayed brighter than beats with low amplitude depolarization spikes. 

6. Lowest Intensity: If Scale Beat Brightness is enabled, sets the amplitude of low amplitude 

depolarization spikes.  

7. Highest Intensity: If Scale Beat Brightness is enabled, sets the amplitude of large amplitude 

depolarization spikes.  

8. FPD Marker checkbox: If enabled, displays a rectangle marking the current T-wave location on each 

field potential, providing a visual verification of the FPD detection accuracy.  

9. FPD Confidence Interval checkbox: If enabled, displays a white whisker plot on the field potentials in 

the cardiac waveform plot indicating the mean T-wave location and the confidence interval as set by 

Confidence Interval Markers (x Std Dev). 

10. Confidence Interval Markers (x Std Dev): Sets the width of the confidence interval displayed as a 

multiple of the standard deviation. 

The checkbox controls can also be set by right-clicking on the beat waveform plots in the Cardiac Beat Plots 

panel, and selecting/deselecting the display options. 

Note: When Cardiac: Contractility Acquisition Settings are used, only relevant parameters are displayed in 

the Cardiac Beat Detector Settings, as shown below.  
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2.3.10. Cardiac Statistics Compiler 

The Cardiac Statistics Compiler (displayed as Statistics Compiler in the Streams pane) uses the outputs of a 

Cardiac Beat Detector to calculate a variety of cardiac endpoints. These metrics are calculated for individual 

electrodes, well-wide averages, and treatment group averages. Treatment groups are defined by the Plate 

Map Editor in the Active Plate interface. The Cardiac Statistics Compiler can only be used after a Cardiac 

Beat Detector and only on recorded data. It has one output file, Advanced Metrics (.csv). See Section 9.2 for 

more information on file types.  

 

 

 

The settings window has four sections, Saved Data, Covered Electrode Threshold, Beat Quality Control, and 

FPD Measure Quality Control. The Saved Data section identifies what information is output to the Advanced 

Metrics file. The options include:  

1. File Header: If enabled, output file will start with a list of all experiment acquisition and analysis 

settings.  

2. Aggregated Well Statistics: If enabled, output file will include well-wide averages in addition to 

individual electrode metrics. 

3. Aggregated Treatment Statistics: If enabled, output file will include treatment group averages as 

defined by the Plate Map Editor. 

4. Source Data: If enabled, output file will include lists of individual beat statistics for both synchronized 

beats and electrode beats. 
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5. Supplemental Statistics: If enabled, additional cardiac endpoints are included in the file. Examples 

include median and median absolute deviation (MAD) for each metric and additional conduction 

velocity metrics. 

 

The Covered Electrode Threshold section defines a threshold for identifying electrodes with sufficient cell 

coverage. Electrodes with a resistance greater greater than the value specified in the Minimum Covered 

Resistance field are considered Covered Electrodes. In general, fully uncovered CytoView microelectrodes 

with media only in the well have a resistance of 8 – 12 kΩ. (See FAQs in Section 8.3 for more detail). The 

output file reports the resistance of each electrode, the number of covered electrodes in each well, as well as 

the weighted mean resistance, the mean resistance across only the covered electrodes in a well.  

Note: This section is only available with the MEA Viability Software Module. See Chapter 7 for more 

information. 

The Beat Quality Control section limits which beats are averaged and reported. The options include: 

1. Limit to Region of Most Stable Beat Period: If enabled, metrics will be calculated from the most stable 

well beats, calculated as N consecutive well beats with the lowest beat period standard deviation. If 

fewer than N beats are detected in the file, all detected beats will be used to calculate metrics. 

2. Number of Beats in Stable Region: Defines the number of consecutive well beats used for the Limit to 

Region of Most Stable Beat Period checkbox. 

3. Included Source Data: Specifies whether to output the source data for all well beats in the recording 

(All Beats) or for the most stable well beats only (Most Stable Region Only).  

Note: All Beats is required for the Cardiac Analysis Tool. 

4. Region Limit: Sets the time window of the recording used to search for the most stable beats. Specify 

the time window by selecting Entire Playback, Start of Playback, or End of Playback, to choose the 

entire recording, the beginning with or without an offset, or the end of the recording, respectively. 

5. Limit Statistics to Most Common Propagation Pattern checkbox: If enabled, metrics will be calculated 

from well beats that follow the most common propagation pattern.  

 

The FPD Measure Quality Control section removes FPD measurements from beats and electrodes that do not 

meet user-specified statistical bounds, improving the accuracy of electrode and well-wide FPD averages. The 

number of remaining electrodes that are used for the well FPD calculation after the criteria are applied is 

output as “Total FPD Electrodes”. The user-specified statistical bounds are applied in the following order: 

1. Beat to Beat FPD Consistency: Individual beat metrics are compared to the mean or median of all 

beats on that electrode. FPD values for individual beats are removed when they exceed the specified 

number of standard deviations (x STD) or median absolute deviations (x MAD) from the mean or 

median, respectively. 

2. Electrode FPD Consistency: Electrodes with large beat-to-beat variability in FPD are removed. 

Consistency is based on the coefficient of variation (CoV) of the FPD, with limits set as a percentage 

([standard deviation/mean] *100).  
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3. Well FPD Consistency: Electrodes with an FPD mean that exceeds the specified number of standard 

deviations (x STD) or median absolute deviations (x MAD) from the well mean or median are 

excluded from the Well Average FPD.  

 

Note: When Cardiac: Contractility Acquisition Settings are used, there is not an FPD Measure Quality Control 

section in the Statistics Compiler Settings since those settings are not relevant for contractility.   

2.3.11. Neural Statistics Compiler  

The Neural Statistics Compiler (displayed as Statistics Compiler in the Streams pane) uses the outputs of a 

Spike Detector and Burst Detector processor to calculate a variety of spike, burst, and synchrony metrics. 

These metrics are calculated for individual electrodes, well-wide averages, and treatment group averages. 

Treatment groups are defined by the Plate Map Editor in the Active Plate interface. The Neural Statistics 

Compiler can only be used after a Burst Detector or a Neural Event Detector and only on previously recorded 

data. It has one output file, Advanced Metrics (.csv). See Section 9.2 for more information on file types.  

 

The Saved Data section identifies what information is output to the Advanced Metrics file. The options include:  

1. File Header: If enabled, output file will start with a list of all experiment acquisition and analysis 

settings.  

2. Aggregated Well Statistics: If enabled, output file will include well-wide averages in addition to 

individual electrode values. 

3. Aggregated Treatment Statistics: If enabled, output file will include treatment group averages as 

defined by the Plate Map Editor. 

4. Viability Data: If enabled, output file will include viability metrics. 

5. Synchrony: If enabled, output file will include synchrony metrics. 

 

The Covered Electrode Threshold section defines a threshold for identifying electrodes with sufficient cell 

coverage. Electrodes with a resistance greater than the value specified in the Minimum Covered Resistance 
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field are considered Covered Electrodes. In general, fully uncovered CytoView microelectrodes with media 

only in the well have a resistance of 8 – 12 kΩ. (See FAQs in Section 8.3 for more detail). The output file 

reports the resistance of each electrode, the number of covered electrodes in each well, as well as the 

weighted mean resistance, or the mean resistance across only the covered electrodes in a well.  

Note: This section is only available with the MEA Viability Software Module. See Chapter 7 for more 

information. 

The Active Electrode Selection Criteria section identifies active electrodes defined as having a mean firing rate 

greater than the value defined in the Minimum spike rate field. The output file reports the number of active 

electrodes in each well, as well as the weighted mean firing rate, the mean firing rate averaged across only 

the active electrodes. 

2.4. FILE PLAY AND DISPLAY CONTROLS 

The File Play and Display controls activate the current stream and control data display in the active window.  

The File Play options are:  

Control Icon Description 

Load/Eject Plate 

 

Engages or disengages a plate from the Maestro. The Maestro 

door automatically closes when an MEA plate is docked and 

opens when an MEA plate is undocked. Right-click the 

Load/Eject button and select Keep Door Open to keep the 

Maestro door open regardless of plate presence. 

Stop 

 

Stops the current stream. A subsequent Play or Record 

command will resume streaming a .raw file from the start. A live 

stream will resume starting with a voltage offset.   

Pause 

 

Pauses the current stream. A subsequent Play or Record 

command will resume a .raw file at the time it was paused. A 

live stream will resume without a voltage offset. 

Play 

 

Starts the current stream without saving. Data will be displayed 

in the Control Bar panels. When playing back a file, right-click 

the Play button and select Accelerate Playback to replay the 

file faster than real time. 

Record 

 

Records and plays the current stream. Data will be displayed in 

the Control Bar panels and outputs selected in Experiment 

Setup Properties will be saved. When playing back a file, right-

click the Record button and select Accelerate Recording to 

replay the file and save the analysis file(s) faster than real 

time. 

 

The Display controls scale data displayed in the active window and, in certain panels, provides a drop-down 

menu to select the type of data displayed. Use the Source drop-down to select the type of data displayed. Use 

the zoom in ( ), zoom out ( ), and reset scale ( ) controls to change the voltage and time scales. The scale 
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is indicated above the control as X units per division. The divisions are noted along the edges of the active 

window. 

 

For Cardiac: Contractility, the Display controls are used to change the contractility (expressed as a percent 

change in impedance) and time scales.  

 

2.5. STATUS BAR 

The Status Bar at the bottom of the active window displays the file status of the current data stream. The time a 

stream has played for is indicated on the left. The duration of a recording is indicated on the right. The text in 

the middle of the bar includes the Stream name, play status, well, and treatment information if present in the 

Active Plate. When the active stream is a previously recorded file, the status bar represents the time within the 

file. Click on the status bar to move to a particular time in the recording. The color of the status bar indicates 

the current file status as outlined in the table below. 

 

Color File Status 

Light Gray Current stream is inactive, or live stream is active and playing. 

Blue Gray Offset correction in progress. 

Green Current stream is a recording. Dark green indicates time before the 

currently displayed data.  

Red Current stream is recording. Output files specified in Experiment Setup 

Properties are being saved. 

2.5.1. Adding Timestamp Notes 

It is possible to add notes with a timestamp to a recording. Notes can mark important events for further review 

during analysis. Notes may be added while the file is playing, paused, or recording. A line will appear in the 

Status Bar at the time of the notes addition. When selected or scrolled over, the note will be displayed.  

To add a timestamp note: 

1. Click Add Note located to the right of the Status Bar at the desired file time.  

Stream Play Time Recording Duration 



AxIS Navigator Overview 

[28]  

 

2. Type the desired text and click Accept (green checkmark).  

3. Click the  in the top right corner to close the Notes panel.  

 

2.6. CONTROL BAR 

The Control Bar interface switches the panel displayed in the active window. By default, only panels used by 

the current configuration in the Streams pane are displayed. To switch the active panel, click on the thumbnail 

or select the panel from the View menu.  

 

 

Name Description Dependency 

Experiment Setup Properties File information controls. Sets save location, 

experiment notes, recording names, and file 

types.  

Always visible 

Scheduled Recording Setup Automated recording and stimulation 

controls. 

Live data only 

Stimulation Studio Stimulation definition controls. Always visible 

Experiment 

Setup 

Stimulation 

Studio 

Continuous 

Plots 

LFP  

Plots 

Scheduled 

Recording 

Environment 

Control 

Activity 

Map 

Spike  

Plots 

LEAP  

Setup 

Accept, 

Cancel, 

Delete 

Add Note Note Location 

Cardiac 

Beat Plots 
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Environmental Control Temperature and CO2 controls. Live data only 

Activity Map Plate-wide visualization of spike rate, beat 

rate and amplitude, LFP amplitude, or 

viability. 

Spike Detector 

Neural Event Detector 

Cardiac Beat Detector 

Continuous Waveform Plots Displays a raw and/or filtered voltage over 

time plot for every electrode in a selected 

well. 

Data stream active 

Spike Plots Displays spike waveforms for every 

electrode in a selected well and a well 

raster plot. 

Spike Detector 

Neural Event Detector 

LFP Plots Displays LFP waveforms for every electrode 

in a selected well. 

Neural Event Detector 

 

Cardiac Beat Plots Displays cardiac waveforms, conduction 

maps, and beat period plots for every 

electrode in a selected well.  

Cardiac Beat Detector 

LEAP Setup Select wells and electrodes for LEAP 

induction, or add/remove LEAP tags in 

recorded raw files. 

LEAP Acquisition Settings 

or LEAP tags present in file 

 

2.6.1. Experiment Setup Properties 

The Experiment Setup Properties panel specifies the recording destination, experiment description, and the file 

names and types to record. Available recording file types (see Section 9.2) are determined by the data 

processors present in the Streams pane.  

 

Set Recording Destination 

Experiment Details 

File Name 
File Type 

Experiment Setup  
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The Recording Name, Investigator, and Description fields are optional fields for the user to enter information 

about the experiment. This information will be saved with the file and appear on the analysis output files. They 

may be entered or updated at any time. Recording Name and Investigator and can be applied to file names 

as macros (Section 9.2.1).  

To update the Recording Name, Investigator, or Description fields on a previously recorded file: 

1. Click on the Experiment Setup Properties panel in the Control Bar. 

2. Click on the field and enter the new information 

3. Click Write to File.  

Note: To undo changes prior to clicking Write to File, click Reset. 

To set the file save location: 

1. Click on the Experiment Setup Properties panel in the Control Bar. 

2. Click the Browse… button. 

3. Navigate to and select the destination folder.  

Note: When analyzing previously recorded data, analysis files generated are saved to the folder of 

the original data. This destination cannot be changed in AxIS Navigator. 

2.6.2. Scheduled Recording Setup 

The Scheduled Recording Setup panel automates data recording and stimulation. The panel is divided into 

two sections: Settings and Status. 

 

The Settings dialog controls how and when a file is recorded.  

 

Scheduled Recording 

Settings 

Status 

Start Schedule 

Scheduled Recording 
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Field Description Options 

Record Every1 The interval between the start of 

each recording 

Seconds, Minutes, Hours, or Days 

Record For The duration of each recording Seconds, Minutes, Hours, or Days 

Starting The start time of the first 

recording 

Immediately – begin when Start Schedule is 

clicked. 

At – begin at a specified time (mm/dd/yyyy 
hh:mm:ss). 
Note: 24 hour time or AM/PM may be used. If 
starting Immediately, play the stream first to allow 
voltage offset to complete, then Start Schedule. 

Execute Number of repeats Until Stopped – continue making recordings at set 

interval until Stop Schedule is clicked. 

Once – Only create one recording.  

Until – continue at set interval until a specified 

time. 

Exactly – repeat at set interval for X times. 

Auto Stimulate Starts the currently active 

stimulation protocol during a 

scheduled recording 

Note: Only available if 
stimulation protocol is set to 
Once in Stimulation Studio 

From Recording Start – When to start the 

stimulation protocol after the start of a recording if 

Auto Stimulate is selected.  

1The value for Record Every cannot be set to 0. To take one scheduled recording, select “Once” from the 

Execute drop down. 

 

After specifying the Settings, click Start Schedule to begin the scheduled recording protocol.  

Note: For Viability Configurations, a message below Record For will indicate, “Viability will be acquired at the 

start of each file.” Users must design their scheduled recordings to account for the viability measurement (~1 

min) that is taken at the start of each scheduled time point (see Section 8.2).  

The example below shows the recording and stimulation times for a Scheduled Recording Setup as follows: 
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 8:00:00 AM 8:15:00 AM 8:30:00 AM 8:45:00 AM 9:00:00 AM 

Record                            

Stimulate                               

The Status panel provides feedback about the recording schedule. 

Field Description 

Running Status Current recording status: 

Recording – a scheduled recording is in progress 

Waiting to Record – another recording is scheduled to begin 

Waiting to Trigger – a scheduled recording is in progress and a stimulation is 

scheduled to begin 

Next Recording Start time of the next scheduled recording  

Previous Recording Start time of the last completed recording 

2.6.3. Stimulation Studio 

The Stimulation Studio panel designs both electrical and optical stimulation protocols. The panel has four key 

components: the stimulation blocks, stimulation lanes, global repeat settings, compiled pattern view, and 

electrode or LED selector. See Chapter 4 for more information about building stimulation waveforms, selecting 

stimulation electrodes or LEDs, and applying a stimulus.  

 

2.6.4. Environmental Control 

The Environment Control panel displays current temperature and CO2 levels. The Environmental Control 

thumbnail displays the current temperature and CO2 status. The color of the text indicates the current status.  

Name Status Description 

Stimulation Blocks Compiled Pattern View 

Stimulation Lanes 

Electrode or 

LED Selector 

Stimulation Studio 

Global Repeat Settings 
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Gray Text Maestro is connected and the heater or CO2 control is off. 

 

Blue Text 
Maestro is connected, heater or CO2 control is on, and 

temperature or CO2 is slightly below the set point. 

 

Green Text 
Maestro is connected, heater or CO2 control is on, and 

temperature or CO2 is at the set point. 

 

Yellow Text Temperature or CO2 is slightly above the set point. 

 

Red Text Temperature or CO2 is greatly above the set point. 

 

The screen on the Maestro Pro also displays temperature and CO2 status. 

When a valid plate is docked in the Maestro, heater control is automatically turned on with the temperature 

set to 37°C, and CO2 control is automatically turned on with the CO2 concentration set to 5%. 

To set a custom temperature or CO2 concentration, or to use a custom gas mix, navigate to the Environment 

Control panel using the Control Bar. The active window is shown below:  

 

 

Heater Settings 

CO2 Settings 
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The temperature and CO2 plots display the current set point as a dashed line and the current temperature or 

CO2 as a solid line. To the right of the temperature plot are the heater controls, including the Heater Control 

switch and Temperature (°C) set point. The CO2 control box contains the CO2 Control switch, the Gas Source, 

and the Concentration (%) set point if 100% CO2 is used.  

A warning will display if the temperature is more than 1°C away from the set point or the CO2 concentration is 

more than 1% away from the set point for longer than 5 minutes.  

Like all incubators or environmental controllers, the system performs best when left in a closed and undisturbed 

state. For optimal environmental control, leave the Heater Control on and the Maestro door closed when not 

in use. The Heater Control is automatically turned off when the Maestro is turned off or when a plate is 

undocked. 

If Auto Enable Heater is selected, the heater is only on when an Axion MEA plate is docked and the door is 

closed. If Auto Enable Heater is not selected, the heater is manually controlled by the Heater Control switch 

(as long as the door is closed). Note: If the MEA plate barcode is not recognized, the heater will not be 

automatically enabled. 

To set the temperature to a custom temperature: 

1. Click on the Environmental Control panel in the Control Bar. 

2. Set the desired temperature in the Temperature (°C) field (range Ambient + 5°C to 46°C). 

Note: Temperatures above 37°C may be detrimental to cells.  

Legacy Heater Control mimics the original Maestro’s heater control scheme, in which heat is only applied 

from below the plate. Note: This setting may be well suited for some cell types, but condensation may arise 

over time in the absence of door heating.  

To use Legacy Heater Control settings: 

1. Click the gear in the Heater Control settings. 

2. Check the box next to the Legacy Heater Control. 

If Auto Enable Gas is selected, CO2 is on only when an Axion MEA plate is docked and the door is closed. If 

Auto Enable Gas is not selected, CO2 is manually controlled by the CO2 Control switch (as long as the door is 

closed). Note: If the MEA plate barcode is not recognized, gas will not be automatically enabled. 

When the door is opened, CO2 Control is automatically turned off, regardless of Auto Enable Gas setting. The 

CO2 concentration cannot be maintained when the door is open. The CO2 Control is automatically turned off 

when the Maestro is turned off to conserve gas. To set the CO2 concentration to a custom concentration: 

1. Click on the Environmental Control panel in the Control Bar. 

2. Select 100% CO2 from the Gas Source drop-down menu. 

3. Set the desired CO2 concentration in the Concentration (%) field. 
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To use pre-mixed gas rather than 100% CO2: 

1. Click on the Environmental Control panel in the Control Bar. 

2. Select Custom Mix from the Gas Source drop-down menu. 

3. Use an inline flow meter to control the flow of gas into the Maestro. 

To stop controlling temperature or CO2: 

1. Click the Heater Control or CO2 Control switch to Off. 

2.6.5. Activity Map 

The Activity Map panel displays a heat map of activity across the entire plate, providing an intuitive way to 

visualize differences between wells/conditions.  

 

The metric displayed in the map is selected by the Source drop-down menu. The options available depend on 

the data processors in the Streams pane as listed below:  

Data Processor Source Metric 

Cardiac Beat Detector Beat Rate (BPM) – All Cardiac Acquisition Settings 

Spike Amplitude (µV) – Cardiac: Standard, Broadband, and LEAP 

Beat Amplitude (%) – Cardiac: Contractility 

Viability (Resistance, kΩ)1 – All Cardiac + Viability Acquisition Settings 

Spike Detector Spike Amplitude (µV) – All Neural Acquisition Settings 

Spike Rate (Spikes/Sec) – All Neural Acquisition Settings 

Viability (Resistance, kΩ)1 – All Neural + Viability Acquisition Settings 

Neural Event Detector Spike Amplitude (µV) – Neural: Broadband 

Source 

Activity Map 

Scale 
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Spike Rate (Spikes/Sec) – Neural: Broadband 

LFP Amplitude (µV) – Neural: Broadband 

Viability (Resistance, kΩ)1 – Neural: Broadband+ Viability Acquisition 

Settings 
1Only available with the MEA Viability software module 

For non-viability metrics, the refresh rate of the Activity Map is set by the Interval setting in the Spike Detector 

(See Section 2.3.5). Small intervals increase the refresh rate, providing real-time feedback. Larger intervals 

will display a persistent signal integrated over many spikes. When set to Viability, the Activity Map displays 

the resistance values at the time listed at the top of the map (single time point).  

Color corresponds to the magnitude; red or white areas have the highest magnitudes while blue and black 

areas have the lowest. The Activity Map scale is located to the right. The scale auto-adjusts by default but may 

be set to a fixed value in the Plot Settings dialog. For Viability, yellow areas indicate high levels of viable cell 

coverage, whereas dark blue and black indicate less cell coverage. 

To manually adjust the Activity Map scale: 

1. Click on the Activity Map panel in the Control Bar. 

2. Deselect Auto Scale, if enabled. 

3. Enter the desired scale maximum into the Maximum field.  

4. Click Enter. 

To copy the Activity Map: 

1. Click on the Activity Map panel in the Control Bar. 

2. Right-click on the Activity Map and select Copy. 

Selecting a well in the Activity Map will change the active well displayed in the Continuous Waveform Plots, 

Spike Plots, and Cardiac Beat Plots panels. 
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2.6.6. Continuous Waveform Plots 

The Continuous Waveform Plots panel displays continuous voltage data (for most Acquisition Settings) or 

contractility data (for Cardiac: Contractility Acquisition Settings) for each electrode of the active well. Select 

the active well by clicking on the desired well on the Active Plate or Activity Map.   

 

The electrode ID consists of two digits, the column and row, and is displayed in gray text in the upper left 

corner of each plot. Adjacent to the electrode ID is the electrode noise level, displayed in µV, whenever 

voltage data is displayed. Right click on the electrode and select Hide RMS to hide noise values. If a Viability 

configuration (only available with the MEA Viability Software Module) was used, the cell-electrode Resistance 

value is displayed in kΩ adjacent to the noise value. Right-click on the electrode and select Hide Viability to 

hide resistance values. If -- kΩ is displayed, the electrode impedance is out-of-range and resistance cannot be 

measured. See Chapter 7 for more information.  

If the file contains LEAP tags, an inverted gray triangle is displayed in the 

upper right corner of the plot for electrodes that are tagged, indicating 

those electrodes were selected for LEAP induction.  

LEAP induced 

Display Controls 

Active Well 

Continuous Waveform Plots 

Electrode ID Noise 
Viability 



AxIS Navigator Overview 

[38]  

 

If the file is recorded in the Neural → Broadband Spontaneous configuration, 

both the spike and LFP waveforms will be shown in the Continuous Waveform 

Plot.  

The x and y scales are adjusted in the Display controls. Division marks along 

the outside of the active window indicate the zoom level chosen in the Display 

controls section. See Section 2.4 for more information about the Display 

controls. By default, electrodes are laid out in the active window by physical location but may be viewed as a 

vertical stack.  

To view the electrodes in a vertical stack: 

1. Click on the Continuous Waveform Plots panel in the Control Bar. 

2. Right-click on the active window and select Stack Plots. 

Note: The option to Stack Plots is not available when using CytoView MEA 6 or NETRI 

NeuroFluidicsTM MEA plates. 

  

A blank plot indicates an electrode has been turned off. Right click on an electrode plot and select Disable 

Electrode to turn it off or on, or use the Plate Map Editor (Section 2.2.1). 

The continuous waveform plot has two copy options. To copy a single electrode, right-click on the electrode 

and select Copy Electrode Waveform. To copy the entire well plot, right-click anywhere on the plot and select 

Copy Well Plot.  

AxIS Navigator enhances the visualization of the continuous raw voltage data to highlight the important 

features of the signals. The plotting enhancements affect the data display only – the full, original, raw 

continuous voltage data is used for all analysis. The enhanced plotting options are described in the table 

below. 

Name Description Dependency 

Enhance for Neural1 Subthreshold samples are filtered to highlight 

detected neural spikes. 
Neural Configurations 

Enhance for Cardiac Field potential depolarization spikes are 

plotted at full scale, and signals between the 

spikes are filtered. 

Cardiac Configurations 

Enhance for LEAP Applies a filter that removes the field 

potential components of the signal to 

highlight the LEAP signals. 

Cardiac → LEAP 

Configurations 

1Enhance for Neural is only available for the high-frequency Spike Trace in the Neural → Broadband 

Spontaneous configuration. 

 

Enhanced plotting is selected by default. To disable or enable enhanced plotting: 

1. Right-click on the stream in the Streams section. 

2. Select Plot → Enhance for Neural, Enhance for Cardiac, or Enhance for LEAP. 

Spike Activity 

LFP  
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2.6.7. Spike Plots 

The Spike Plots panel uses output from a Spike Detector and Burst Detector (See Sections 2.3.5 and 2.3.6, 

respectively) to display the spike voltage waveforms and raster plot of the active well. Like the Continuous 

Waveform Plots, each electrode of the active well is represented in the active window of the Spike Plots 

display. The gray electrode ID corresponds to the electrode ID in the Continuous Waveform Plots and the 

adjacent number is the most recent spike amplitude, displayed in µV. Right click on the electrode and select 

Hide Amplitude to hide amplitude values. If a Viability configuration (only available with the MEA Viability 

Software Module) was used, the cell-electrode Resistance value is displayed in kΩ adjacent to the amplitude 

value. Right-click on the electrode and select Hide Viability to hide resistance values. If -- kΩ is displayed, the 

electrode impedance is out-of-range and resistance cannot be measured. See Chapter 7 for more 

information. 

The waveform plots overlay each spike with the brightest trace representing the most recently detected spike 

on that electrode. Previously detected spikes fade to black. Empty black panels indicate no spikes have been 

detected on those electrodes. Spike detection and display settings can be adjusted in the Spike Detector 

Settings (See Section 2.3.5).  

The spike waveform plots will display a maximum of 20 spikes overlaid at once. To specify how often spike 

waveforms are removed from the plot, right-click on the plot and select Waveform Clearing. Options include: 

After 1 Minute Spike waveforms are cleared 1 minute after they are detected. 

At End Of Raster 

Spike waveforms are cleared after they no longer display in the 

raster plot. Thus, the number of spikes displayed depends on the 

zoom level of the raster plot. 

Manual Spike waveforms are not cleared unless Clear Spikes is selected.  

Spike Plots 

Raster Plot 
Raster Zoom 

Display Controls 

Electrode ID 

Viability 

Spike Amplitude 
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In all cases, if more than 20 spikes are detected on a given electrode, the oldest waveforms are cleared as 

new waveforms are plotted on top. 

The x and y scale of the waveform plots are adjusted in the Display controls. Division marks along the outside 

of the active window indicate the zoom level chosen in the Display controls section. See Section 2.4 for more 

information about the Display controls. By default, electrodes are laid out in the active window by physical 

location but may be viewed as a vertical stack.  

To view the electrodes in a vertical stack: 

1. Click on the Spike Plots panel in the Control Bar. 

2. Right-click on the active window and select Stack Plots. 

Note: The option to Stack Plots is not available when using CytoView MEA 6 plates. 

 

The spike waveform plot has two copy options. To copy the entire well image, right-click anywhere on the plot 

and select Copy Well Plot. To copy a single electrode, right-click on the electrode and select Copy Electrode 

Waveform. This copies both the electrode image as well as the time and voltage values used to generate the 

image. To paste the electrode image, right-click to select Paste Special and choose the image option. When 

pasting the data samples, the first column contains the time in seconds, and the remaining columns list the 

voltage values associated with each time sample for the displayed spikes. Each column contains the data 

samples for a single spike waveform, up to the maximum of 20 spikes displayed at any given time, with the 

most recent spike data in the last column.  

 

The raster plot at the bottom shows a running display of marks indicating the time each spike occurred with 

each row on the plot displaying the spikes from a single electrode. Single-electrode bursts are displayed in the 

color indicated by the Burst Detector while network bursts are indicated by a box of the contrasting color. 

Right-click to enable/disable display of network bursts. The time scale is controlled by the zoom controls on 

the right, allowing monitoring of spike history over long timescales. 

The raster plot can be copied as an image. To copy the raster plot, right-click on the raster plot and select 

Copy. 

When electrical or optical stimulation is used, the stimulation protocol can be designed such that AxIS 

Navigator saves stimulation time tags to the .raw file. Stimulation tags contain information about the timing of 

the stimulus (see Chapter 4 for more details about stimulation). After starting the stimulation or when replaying 

a file containing stimulation tags, inverted white triangles will display above the raster plot indicating the time 

the stimulation was applied. 
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2.6.8. LFP Plots 

The LFP Plots panel uses output from a Broadband Processor and Neural Event Detector (See Sections 2.3.5 

and 2.3.8, respectively) to display the LFP waveforms. Like the Continuous Waveform Plots, each electrode of 

the active well is represented in the active window of the LFP Plots display. The gray electrode ID corresponds 

to the electrode ID in the Continuous Waveform Plots and the adjacent number is the most recent LFP 

amplitude, displayed in µV. Right click on the electrode and select Hide Amplitude to hide amplitude values. If 

a Viability configuration (only available with the MEA Viability Software Module) was used, the cell-electrode 

Resistance value is displayed in kΩ adjacent to the amplitude value. Right-click on the electrode and select 

Hide Viability to hide resistance values. If -- kΩ is displayed, the electrode impedance is out-of-range and 

resistance cannot be measured. See Chapter 7 for more information. 

The waveform plots overlay each LFP with the brightest trace representing the most recently detected LFP on 

that electrode. Previously detected LFPs fade to black. Empty black panels indicate no LFPs have been 

detected on those electrodes. LFP detection and display settings can be adjusted in the Neural Event Detector 

Settings (See Section 2.3.8).  

 

Stimulation 

Viability 

LFP Plots 

Display Controls 

LFP Amplitude 
Electrode ID 
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The LFP waveform plots will display a maximum of 7 LFPs overlaid at once. To specify how often LFP 

waveforms are removed from the plot, right-click on the plot and select Waveform Clearing. Options include: 

After 1 Minute LFP waveforms are cleared 1 minute after they are detected. 

Manual LFP waveforms are not cleared unless Clear LFPs is selected.  

 

In all cases, if more than 7 LFPs are detected on a given electrode, the oldest waveforms are cleared as new 

waveforms are plotted on top. 

The x and y scale of the waveform plots are adjusted in the Display controls. Division marks along the outside 

of the active window indicate the zoom level chosen in the Display controls section. See Section 2.4 for more 

information about the Display controls. By default, electrodes are laid out in the active window by physical 

location but may be viewed as a vertical stack.  

To view the electrodes in a vertical stack: 

1. Click on the LFP Plots panel in the Control Bar. 

2. Right-click on the active window and select Stack Plots. 

Note: The option to Stack Plots is not available when using CytoView MEA 6 plates. 

 

The spike waveform plot has two copy options. To copy the entire well image, right-click anywhere on the plot 

and select Copy Well Plot. To copy a single electrode, right-click on the electrode and select Copy Electrode 

Waveform. This copies both the electrode image as well as the time and voltage values used to generate the 

image. To paste the electrode image, right-click to select Paste Special and choose the image option. When 

pasting the data samples, the first column contains the time in seconds, and the remaining columns list the 

voltage values associated with each time sample for the displayed LFPs. Each column contains the data 

samples for a single LFP waveform, up to the maximum of 7 LFPs displayed at any given time, with the most 

recent LFP data in the last column.  

 

2.6.9. Cardiac Beat Plots 

The Cardiac Beat Plots panel uses output from a Cardiac Beat Detector (See Section 2.3.7) to display cardiac 

voltage or contractility waveforms, conduction maps, beat period plots, and other relevant figures for the 

active well. The Cardiac Beat Plots panel displays different figures depending on the Acquisition Settings used 

for recording. Each variation is described below. 
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Cardiac: Standard, Broadband, and LEAP (voltage data) 

For voltage data, the Cardiac Beat Plots panel displays the cardiac voltage waveforms, conduction maps, 

and beat period plots of the active well. Like the Continuous Waveform Plots, each electrode of the active well 

is represented in the active window of the Cardiac Beat Plots display. The gray electrode ID corresponds to 

the electrode ID in the Continuous Waveform Plots and the adjacent number is the average amplitude of the 

depolarization spike, displayed in µV. The amplitude value can be hidden by right-clicking on the plot and 

selecting Hide Amplitude. If a Viability configuration (only available with the MEA Viability Software Module) 

was used, the cell-electrode Resistance value is displayed in kΩ adjacent to the amplitude value. Right-click on 

the electrode and select Hide Viability to hide resistance values. If -- kΩ is displayed, the electrode impedance 

is out-of-range and resistance cannot be measured. See Chapter 7 for more information. 

Warning: Measuring MEA Viability shortly after LEAP induction may result in aberrant values. For best results, 

MEA Viability measurements should be made prior to LEAP induction.  

 

 

By default, the average waveform of the last 10 beats is plotted. This may be changed either in the Beat 

Detector Settings (section 2.3.7) or by right-clicking on the plot and selecting/deselecting Averaged Beats. 

Cardiac Beat Plots 

Propagation Map 

Beat Period Plots 

Right-click Menu 

T-wave 

Spike Amplitude Viability 
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The field potential duration (FPD) detection is indicated by the blue rectangle and white whisker plot. It is 

disabled during data acquisition to limit processor workload.  

The x and y scale is adjusted in the Display controls. Division marks along the outside of the active window 

indicate the zoom level chosen in the Display controls section. See Section 2.4 for more information about the 

Display controls. By default, electrodes are laid out in the active window by physical location but may be 

viewed as a vertical stack.  

To view the electrodes in a vertical stack: 

1. Click on the Cardiac Beat Plots panel in the Control Bar. 

2. Right-click on the active window and select Stack Plots. 

Note: The option to Stack Plots is not available when using CytoView MEA 6plates. 

The beat waveform plots have two copy options. To copy a single electrode, right-click on the electrode and 

select Copy Electrode Waveform. This copies both the electrode image as well as the time and voltage values 

used to generate the image. When pasting the data samples, the first column contains the time samples in 

seconds and the second column contains the voltage samples corresponding to the selected beat. To paste the 

electrode image, right-click to select Paste Special 

and choose the image option. To copy the entire well 

image, right-click anywhere on the plot and select 

Copy Well Plot. 

When LEAP is induced, AxIS Navigator saves LEAP 

tags to the .raw file indicating which electrodes were 

selected for LEAP induction (See Chapter 5 for more 

details about LEAP). After inducing LEAP or when 

replaying a file containing LEAP tags, an inverted 

gray triangle is displayed in the upper right corner of 

the plot for electrodes that were selected for LEAP 

induction. An inverted green triangle is displayed for 

the subset of LEAP electrodes for which AxIS Navigator identifies LEAP beats.  

LEAP induced 

LEAP beats detected 
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Note: LEAP beats are only identified if the file is recorded using Cardiac: LEAP Acquisition Settings. When 

other cardiac acquisition settings are used, field potential beats are not identified on electrodes selected for 

LEAP induction. 

To the right of the cardiac waveforms are three plots: the 

Conduction plot, Beat Periods plot, and Beat Period Poincaré 

plot.  

Right-click on any of the plots and select Copy to copy to the 

clipboard. 

The Conduction Plot illustrates the propagation delay at each 

electrode from short (blue) to long (red). The well beat 

originates in the blue region and terminates in the red. The 

electrode column and row numbers are displayed on the x- 

and y-axis, respectively.  

Right-clicking on the Conduction plot presents four display 

options: 

Option Description 

Auto Scale Sets the scale of the plot. Disable to manually adjust the top of the 

scale with Max Delay. 

Animate Conduction Animates the plot with each beat. Disable to view a static plot that 

updates with each beat. 

Extrapolate Missing Electrodes Extrapolates values for electrodes that did not detect a 

depolarization spike.  

Show Missing Electrodes Extrapolated electrodes will be marked with a black circle. 

The Beat Periods plot displays beat period (in seconds) on the y-axis, plotted against beat number on the 

x-axis. The Beat Period Poincaré plot displays 

beat period (in seconds) on the y-axis, 

plotted against the previous beat period on 

the x-axis (BPt+1 vs. BPt ). Beats that exhibit a 

greater than 5% deviation from the previous 

beat are displayed as red, indicative of 

arrhythmia.  

Below the Beat Period Poincaré plot are 

display controls for both plots. Use the zoom 

in ( ), zoom out ( ), and reset scale ( ) 

controls to change time scales. The scale is 

indicated above the control as X units per 

division and N beats. 

Starting Electrode 

Ending Electrode 

No Beat on this Electrode 
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Cardiac: Contractility (contractility data) 

For contractility data, the Cardiac Beat Plots panel displays the cardiac contractility waveforms, conduction 

map, contractility map, and beat periods plot of the active well. Like the Continuous Waveform Plots, each 

electrode of the active well is represented in the active window of the Cardiac Beat Plots display. The gray 

electrode ID corresponds to the electrode ID in the Continuous Waveform Plots and the adjacent number is the 

peak-to-peak amplitude as a percent change from baseline impedance over that electrode. Right-click on the 

electrode and select Hide Amplitude to hide the amplitude values. If a Viability configuration (only available 

with the MEA Viability Software Module) was used, the cell-electrode Resistance value is displayed in kΩ 

adjacent to the amplitude value. Right-click on the electrode and select Hide Viability to hide resistance 

values. If -- kΩ is displayed, the electrode impedance is out-of-range and resistance cannot be measured. See 

Chapter 7 for more information. 

The beat waveform plots have two copy options. To copy a single electrode, right-click on the electrode and 

select Copy Electrode Waveform. This copies both the electrode image as well as the time and contractility 

values used to generate the image. When pasting the data samples, the first column contains the time samples 

in seconds and the second column contains the contractility samples in % (contractility is reported as a percent 

change from baseline impedance) corresponding to the selected beat. To paste the electrode image, right-

click to select Paste Special and choose the image option. To copy the entire well image, right-click anywhere 

on the plot and select Copy Well Plot. 

Note: Contractility beats are only shown if the file is recorded using Cardiac: Contractility Acquisition Settings. 

When other cardiac acquisition settings are used, field potential beats or LEAP beats are identified. 

Right-click Menu 

Beat Period Plots 

Cardiac Beat Plots 

Right-click Menu 

Beat Period Plots 

Contractility Map 

Conduction Map 
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To the right of the cardiac waveforms are three plots: the Composite 

Beat plot/Conduction map, Contractility map, and Beat Periods plot.  

Right-click on any of the plots and select Copy to copy to the clipboard. 

Using the drop-down menu above the plot, the Conduction map can be 

switched to show the Composite Beat plot.  The Composite Beat plot 

displays the composite contractility waveform, computed by averaging 

the contractility waveforms recorded on the individual electrodes in the 

selected well. 

Note: The Composite Beat can include both contracting cells (positive 

waveform deflection) and stretching cells (negative waveform 

deflection) and is influenced by the spatial arrangement of cells over the 

electrode array. The average Beat Amplitude metric calculated during 

analysis (see Section 10.3) provides the average absolute peak-to-

peak amplitude for all electrodes. 

The Contractility map displays a real-time representation of 

fluctuations in the shape of the cell(s) over the electrodes. Each circle 

represents an individual electrode for a selected well and changes in 

size according to its corresponding contractility signal. As the circle 

gets smaller, that represents nearby cells contracting, whereas a circle increasing in size represents 

nearby cells stretching. See Section 6.1 for more information on contractility waveform shapes. 

The Beat Periods plot displays beat period (in seconds) on the y-axis, plotted against beat number on the 

x-axis.  Beats that exhibit a greater than 5% deviation from the previous beat are displayed as red, 

indicative of a possible arrhythmia. 

2.6.10. LEAP Setup 

The LEAP Setup panel is used to design a Local Extracellular Action Potential (LEAP) induction plate map and 

start LEAP induction to acquire extracellular action potential waveforms from cardiomyocytes. This panel 

includes a LEAP Induction Electrode Pattern Selector and a LEAP Well Selector. See Chapter 5 for more 

information about LEAP.  
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CHAPTER 3. DATA ACQUISITION 

The Maestro Pro and Maestro Edge stream data from all electrodes simultaneously. AxIS Navigator can 

record the continuous voltage data from the entire plate at once, and the user may view the data stream with 

various data processors applied. Built-in environmental controls ensure the culture is kept under optimal 

conditions while recording. This chapter reviews how to acquire data from the Maestro systems using AxIS 

Navigator. Section 3.3 contains a step-by-step tutorial for data acquisition. 

3.1. AXIS NAVIGATOR COMMUNICATION WITH THE MAESTRO 

AxIS Navigator communicates with the Maestro through an Ethernet connection. Once the system is 

connected, turn on the Maestro using the button on the side and open AxIS Navigator to begin system 

initialization. Startup can take a few minutes.  

The status lights in the bottom right corner of AxIS Navigator indicate the system status and connectivity. There 

are three status lights: MEA Status, Lumos Status, and Remote Control Status. 

Maestro Connection Status 

 
Device not detected 

 

Blinking. Connected to Device, and Device is booting 

up 

 
Connected to Device, no MEA plate detected 

 
Connected to Device, MEA plate detected 

Electrode Pattern Selector 

LEAP Well Selector 

LEAP Setup 
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Error 

Lumos Connection Status 

 
Lumos not detected 

 

Blinking. Connected to Lumos, and Lumos is booting 

up 

 
Connected to Lumos, and Lumos is on the stand 

 
Connected to Lumos, and Lumos is on the Maestro 

 
Error 

Remote Control Status 

 Remote Control is not enabled 

 Remote Control is enabled 

3.2. CONFIGURING THE MAESTRO FOR ACQUISITION 

3.2.1. Configuring the Hardware 

The Maestro must be configured prior to recording a continuous voltage stream. The hardware bandwidth 

and gain must be set properly for particular applications. These settings affect how the raw continuous voltage 

data is recorded, and cannot be changed after data is recorded. Software filtering added by a Digital Filter 

data processor may be changed after recording (Section 2.3.2).  

Axion provides preset neural and cardiac recording configurations that will automatically configure the 

recommended hardware settings (Section 3.2.2). 

With a device connected, use the Settings dialog from the Maestro stream to adjust the analog acquisition 

settings. To access the Settings dialog, double-click on the Maestro Pro or Maestro Edge stream, or right-click 

and select Settings. 
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The Maestro Settings contain the following options:  

1. Acquisition Settings: Configure the hardware gain and bandwidth. There are 5 options for various 

neural and cardiac applications: 

Option Setting Description 

Neural: Spikes 

(default neural) 

Gain: 1000X 

Bandwidth: 200-3000 Hz 

High gain with a neural bandwidth. 

Recommended for most neural 

applications. 

Neural: Field Potentials Gain: 1000X 

Bandwidth: 1-2000 Hz 

High gain with lower frequency 

bandwidth.  

Neural: Broadband Gain: 1000x 

Bandwidth: 1 – 5000 Hz 

High gain with wide bandwidth. 

Recommended for LFP applications. 

Cardiac: Standard 

(default cardiac) 

Gain: 100X 

Bandwidth: 1-2000 Hz 

Low gain with a cardiac bandwidth. 

Recommended for most cardiac 

applications. 

Cardiac: Broadband Gain: 100X 

Bandwidth: 0.1-2000 Hz 

Low gain with a wide cardiac 

bandwidth. Use if a wider bandwidth is 

desired. 

Cardiac: LEAP Gain: 100X 

Bandwidth: 0.01-2000 Hz 

Low gain with wide bandwidth to collect 

ultra-low frequency content. Use for 

LEAP induction and signal acquisition. 

Cardiac: Contractility Gain: 100x 

Bandwidth: 1– 2000 Hz 

Low gain with a cardiac bandwidth. Use 

for contractility signal acquisition. 

 

2. Median Noise Subtraction option: If enabled, subtracts the median signal from groups of electrodes. 

Grouping is performed based on the system’s electronic architecture. This reduces the noise common 

to the electrode groups, improving the detection of low amplitude signals. Median noise subtraction is 

recommended when recording in Neural: Spikes or Neural Field Potentials, but not Neural: 
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Broadband. In highly active cultures, median subtraction in Neural: Broadband can sometimes create 

mathematical artifacts which appear to be good signals. When an appropriate neural option is 

selected in Acquisition Settings, median noise subtraction is enabled. It is disabled when a cardiac 

option is selected. 

3. Acquire Viability at start of file option: If enabled, a viability measurement will be taken at the start of 

a file when the Play or Record button is pressed. To learn more about the MEA Viability Software 

Module, see Chapter 7. 

3.2.2. Stream Configurations 

In addition to hardware configuration, it is possible to add data processors for easy data visualization during 

a recording. These additional data processors do not impact the raw continuous voltage data recorded and 

are purely for visualization.  

A stream configuration sets the hardware configuration, adds data processors, and applies all the settings for 

data acquisition and visualization. 

AxIS Navigator comes with a variety of preset configurations. Use the Real-Time configurations for data 

acquisition:  

Configuration Processing Applied Description 

Cardiac Real-Time 

Field Potentials Cardiac Beat Detector 

 

Generates activity map, cardiac waveforms, beat 

rate, and conduction information. FPD detection 

disabled. 

Field Potentials Paced Artifact Eliminator 

Cardiac Beat Detector 

 

Generates activity map, cardiac waveforms, beat 

rate, and conduction information. Optimized for 

reducing stimulus artifacts in pacing experiments. 

FPD detection disabled. 

LEAP Cardiac Beat Detector Generates activity map, cardiac waveforms, beat 

rate, and conduction information. Optimized for 

acquiring LEAP signals. 

LEAP Paced Artifact Eliminator 

Cardiac Beat Detector 

 

Generates activity map, cardiac waveforms, beat 

rate, and conduction information. Optimized for 

reducing stimulus artifacts in pacing experiments. 

FPD detection disabled. 

Contractility Cardiac Beat Detector 

 

Generates activity map, cardiac contractility 

waveforms, beat rate, and conduction information.  

Contractility Paced Artifact Eliminator 

Cardiac Beat Detector 

 

Generates activity map, cardiac contractility 

waveforms, beat rate, and conduction information. 

Optimized for reducing stimulus artifacts in pacing 

experiments. 

Neural Real-Time 
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Spontaneous Spike Detector 

Burst Detector 

Generates activity map, spike waveforms, and 

raster plot. Network burst detection disabled. 

Electrically Evoked Artifact Eliminator 

Spike Detector 

Burst Detector 

Generates activity map, spike waveforms, and 

raster plot. Optimized for reducing stimulus artifacts 

in electrically-evoked experiments. Network burst 

detection disabled. 

Optically Evoked  Spike Detector 

Burst Detector 

Generates activity map, spike waveforms, and 

raster plot. Network burst detection disabled.  

Field Potentials 

Spontaneous 

Filter (1Hz – 200 Hz) 

Filter (200 Hz – 2 kHz) 

Spike Detector 

Burst Detector 

Generates activity map, spike waveforms, and 

raster plot. Network burst detection disabled. 

Applied filters are optimized to separate low (LFP) 

and high (spikes) frequency components of the 

signal for spike detection. (Not recommended for 

electrical stimulation) 

Broadband 

Spontaneous 

Broadband Processor 

Neural Event Detector 

Generates activity map, spike and LFP waveforms, 

and raster plot. (Not recommended for electrical 

stimulation) 

Note: In the Acquisition Settings, Neural: Field Potentials or Neural: Broadband is generally selected to 

record lower frequencies for neural applications, while the cardiac Field Potentials Configuration is applied to 

record field potential data for cardiac applications. All of the Neural and Cardiac Real-time configurations 

can be used with the MEA Viability Software Module to allow users to measure impedance data and MEA 

data from the same electrodes. To learn more about the MEA Viability Software Module, please see Chapter 

8. 

To apply a configuration: 

1. Right-click on the data stream. 

2. Select Configuration and navigate to the desired configuration. Click on the configuration. 

Note: A configuration adds data processors but also sets hardware configurations. To record with 

non-default acquisition settings, apply the configuration first and then manually change the acquisition 

settings. See Section 3.2.1. 

 

To save a custom configuration:  

1. Set up a data stream with desired hardware configurations, data processors, and selected file 

outputs. 

2. Right-click on the data stream. 

3. Select Configuration → Save.  

4. Type a file name (.datastreams extension) in the Save Data Stream Configuration dialog and click 

Save. 

 

To load a custom configuration: 
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1. Right-click on the data stream. 

2. Select Configuration → Load. 

3. Navigate to the .datastreams configuration file in the Open Data Stream Configuration dialog.  

4. Click Open. 

 

3.3. LIVE DATA ACQUISITION TUTORIAL 

While most data processor and plate layout settings can be modified after a recording has taken place, there 

are four key settings that must be correct prior to recording: 

1. The Maestro must be communicating with AxIS Navigator (Section 3.1). 

2. The environment control must be on and equilibrated (Section 2.6.4). 

3. The hardware configuration must be set (Section 3.2).   

4. Any stimulus applied must be configured before starting the stimulation or a scheduled recording with 

auto-stimulate (Chapter 4).  

3.3.1. Setting Up for a Recording 

1. Turn on the Maestro with the button on the left side. 

2. Open AxIS Navigator. 

3. Allow the system approximately 1 minute to connect as indicated by the Maestro status light (See 

Section 3.1 for more information on Status Lights). 

Note: The data stream will say “Maestro Pro” or “Maestro Edge” when connected and “No Device 

Connected” when it is not or while it is initiating. 

4. Allow the temperature to stabilize as indicated by the Environmental Control thumbnail.  

Note: The Maestro Pro also displays temperature and CO2 status on the touch screen. 

5. Right-click on the Maestro Pro or Edge stream and select Configuration to apply the desired 

configuration as outlined below. See Section 3.2 for more information on hardware and software 

configurations. 

Note: Configuration options will depend on which software module(s) is active. 

a. Cardiac Real-Time → Field Potentials, LEAP, or Contractility with the option of Paced or 

Viability if needed.  

b. Neural Real-Time → Spontaneous, Electrically Evoked, Optically Evoked, Field Potentials 

Spontaneous, and Broadband Spontaneous with the option of Viability if needed. 
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6. Click the Experiment Setup Properties panel. See Section 2.6.1 for more information on the 

Experiment Setup Properties panel.  

7. Optional: Click Browse to set the save location in the Recording Folder field. By default, files will be 

saved to the Maestro Recordings folder. 

8. Enter a name for the recording in the Recording Name field. Optional: Enter the Investigator and a 

Description in the respective fields. 

9. Select AxIS Raw from the Maestro Continuous Stream drop-down to save the continuous waveform 

data output. Leave all other streams set to Not Recording. See Section 9.2 for more information on 

output file types. 

Note:  The AxIS Raw file will automatically be selected for recording when one of the built-in Real-

Time Configurations is selected. 

10. Optional: Uncheck Auto Name File below the Maestro menu and enter a file name. By default, a 

folder will be created according to the MEA plate barcode, and the file name will be the Recording 

Name specified above. Auto-naming macros are available to add descriptive information to file 

names. See Section 9.2.1 for more information on naming output files. 

Note: File names are appended with a number starting with 000. Recording a file with the same 

name will increase the number appended to the end so no two files share a name. 
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3.3.2. Recording a Single File from the Maestro  

1. Place the MEA plate into the MEA chamber and press the button on the Maestro to engage the MEA 

and close the door. The Maestro will automatically begin controlling CO2. 

2. Allow the MEA to equilibrate while docked in the Maestro for 10-20 minutes prior to recording. 

3. Double click on the Active Plate figure to enter a plate map. 

Note: Plate maps may be imported from a .platemap file or a previously recorded .raw file. 

4. Click Play to view the raw data and begin the voltage offset correction, indicated on the gray status 

bar. The voltage offset correction runs each time AxIS Navigator begins measuring data from the 

stopped state. 

Note: Playback begins automatically after LEAP induction or Viability acquisition 

5. Wait for the voltage offset correction to complete (~30 sec in neural settings and ~1 min in cardiac 

settings). 

6. Click the Record button to begin recording. 

7. Click the Record or Stop button to stop recording. 

3.3.3. Recording from the Maestro using Scheduled Recordings 

1. Repeat Steps 1-5 from the previous section. 

2. Click on the Scheduled Recording Setup panel. See Section 2.6.2.  

3. Enter the desired file duration in the Record For field. 

4. Enter when to begin recording in the Starting field.  

Experiment Setup  

File Name Save AxIS Raw 

Set Save Location 

Experiment Details 
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5. Enter how many times to create a recording in the Execute field. For a single recording, select Once. 

6. If recording more than one file, enter the time between the start of each recording in the Record Every 

field. Note: For Viability Configurations, a message below Record For will indicate, “Viability will be 

acquired at the start of each file.” Users must design their scheduled recordings to account for the 

viability measurement (~1 min) that is taken at the start of each scheduled time point (see Section 8.2).  

7. Click Start Schedule to begin recording. 

8. Click Stop Schedule to stop recording after initiating a scheduled recording. 
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CHAPTER 4. STIMULATION 

Stimulation offers a level of control over cell cultures to evoke specific activity or improve consistency between 

wells and plates. 

The Stimulation Studio panel is used to design both electrical and optical stimulation protocols. Stimulation 

Studio provides a variety of drag and drop blocks that can be used to build custom stimulation waveforms.  

The Stimulation Studio has five major components: 

1. Stimulation Blocks: Predefined functions representing the basic elements of a stimulus protocol.  

2. Stimulation Lanes: Displays the currently assigned stimulation blocks. 

3. Electrode or LED Selector: Assigns the protocol from the selected stimulation lane to specific 

electrodes or LEDs. 

4. Compiled Pattern View: Displays a composite of all stimulation lanes in a time/intensity plot. 

5. Global Repeat Settings: Specifies how many times and how often stimulation waveforms repeat. 

These settings apply globally to all lanes.  

 

 

 

 

Compiled Pattern View 

Electrode or LED 

Selector 

Global Repeat Settings 

Stimulation Studio 

Stimulation Blocks 

Stimulation Lanes 
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4.1. ELECTRICAL STIMULATION 

Electrical stimulation applies a voltage or current waveform directly to the cells via electrodes in the MEA 

plate. It may be used to stimulate cells in a specific region of a well in their native state, without needing to 

biologically modify the cells in any way.  

Because the MEA system records an electrical signal (voltage), electrical stimulation results in a stimulus 

artifact. This artifact is caused by both charge build-up on the electrode and saturation within the amplifiers. As 

a result, AxIS Navigator recording is not accurate during the stimulation. An example of a stimulation artifact is 

shown below in blue. The artifact is an initial biphasic waveform, followed by a slow recovery to baseline. In 

this case the stimulus triggered a depolarization of the cell culture, referred to as a “capture”.  

 

AxIS Navigator uses proprietary techniques to minimize stimulation artifacts. Built-in 

Neural Stimulation (“brain block”) and Cardiac Pacing (“heart block”) blocks are 

provided to optimize artifact elimination at the hardware level. These blocks disable 

the amplifiers when the stimulus is active and rapidly adjust filter settings to manage the 

stimulation artifact and drive the electrode voltage back to pre-stimulation levels as 

quickly as possible. This maximizes the fidelity of voltage recording.  

AxIS Navigator also manages stimulation artifact at the software level through built-in 

configurations, Electrically Paced for cardiac and Electrically Evoked for neural. Both 

real-time and offline versions of these configurations are available for data acquisition 

and analysis, respectively. Both configurations feature the Artifact Eliminator data 

processor, to minimize the appearance stimulation artifact during live streaming and file playback (Section 

2.3.3).  

Note: The Artifact Eliminator relies on cues from the Neural Stimulation and Cardiac Pacing blocks to properly 

remove artifact. Applying the Artifact Eliminator with custom stimulations will have no effect. 

For data acquisition with electrical stimulation: 

1. Build the stimulation protocol according to Section 4.1.2.  

2. Start recording data according to Section 3.3, by selecting the desired configuration as outlined 

below: 

a. Cardiac Real-Time → Field Potentials Paced, LEAP Paced, or Contractility Paced with the 

option of Viability if needed.  

b. Neural Real-Time → Electrically Evoked with the option of Viability if needed.  
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3. Click the Trigger button in the bottom right corner to begin the stimulation protocol manually. Click 

again to stop. 

Note: If Once is selected in the Global Repeat Settings, the stimulation protocol may be started 

automatically by the Scheduled Recording Setup panel. See Section 2.6.2. 

For data analysis with electrical stimulation: 

1. Analyze data according to Section 9.5, selecting the Field Potentials Paced, LEAP Paced, or 

Contractility Paced or Electrically Evoked configuration. 

Note: See the ‘Neural Metric Tool’ for evoked activity analysis options for neural analysis. 

4.1.1. Electrical Stimulation Blocks 

The electrical stimulation blocks are:  

Block Icon Description 

Cardiac Pacing 

Stimulation 

 

Recommended stimulation block for cardiac applications for use with 
Cardiac Electrically Paced configuration. Applies a Biphasic 

Stimulation pulse (Voltage Stimulation mode) with artifact elimination 

routine optimized for cardiac stimulation. Set duration with Stimulus 

Duration in Pulse Settings dialog. Forces the voltage output to match 

Voltage as long as Max Current has not been reached. Use 

Stimulation Paddles for E-Stim+ Classic MEA 48, CytoView MEA 24 

plates and Microelectrode for all other MEAs. 

Note: This block already contains a stimulation time tag. Do not use 
an additional Electrical Stimulation Tag block with this block. 

Neural 

Stimulation with 

Artifact 

Elimination  
 

Recommended stimulation block for neural applications for use with 
Neural Electrically Evoked configuration (not recommended with 
Neural Field Potentials Spontaneous or Broadband Spontaneous). 
Applies a Biphasic Stimulation pulse (Voltage Stimulation mode) with 

artifact elimination routine optimized for neural stimulation. Set 

duration with Stimulus Duration in Pulse Settings dialog. Forces the 

voltage output to match Voltage as long as Max Current has not 

been reached. 

Note: This block already contains a stimulation time tag. Do not use 
an additional Electrical Stimulation Tag block with this block. 

Monophasic 

Stimulation 

 
 

Applies a single phase pulse of a set current or voltage for a set 

duration. Use Stimulus Duration to set the duration. 

Current Stimulation: Forces the current output to match Current as 

long as Max Voltage has not been reached. 

Voltage Stimulation: Forces the voltage output to match Voltage as 

long as Max Current has not been reached.  
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Note: This stimulation will have a larger artifact because the Artifact 
Eliminator Data Processor (Section 2.3.3) only works with the Neural 
Stimulation and Cardiac Pacing Stimulation blocks. 

Biphasic 

Stimulation 

 
 

Applies a dual phase pulse of a set current or voltage for a set 

duration. Use Stimulus Duration to set the durations. 

Current Stimulation: Forces the current output to match Current as 

long as Max Voltage has not been reached. 

Voltage Stimulation: Forces the voltage output to match Voltage as 

long as Max Current has not been reached. 

Note: This stimulation will have a larger artifact because the Artifact 
Eliminator Data Processor (Section 2.3.3) only works with the Neural 
Stimulation and the Cardiac Pacing Stimulation blocks. 

Delay 

 
 

Applies a wait period. Set the duration using the Duration field.  

Stimulation 

Artifact 

Eliminator 
 

 

Discharges the electrode to pre-stimulus voltage. Length of discharge 

set by Discharge Duration. The transition from the stimulating to non-

stimulating state is controlled by the time constant Soft Switch. 

Discharge Strength sets the maximum current used to "pull" charge off 

the electrode and to ground. While this block applies discharge, it 

does not enable software-based artifact elimination via the Artifact 

Eliminator Data Processor. 

Loop Container 

 

Repeats any blocks contained within the loop a set number of times. 

Double-click the repeat number (xN) in the top right corner of the 

block to set the number of times. 

Electrical 

Stimulation Tag 

 

Set the location of a “tag” or time stamped note to indicate a 

stimulation occurred. Tags are useful for visualization and analysis of 

evoked activity. Only one tag block can be set per stimulation 

protocol, so tags cannot be assigned to multiple lanes of stimulation.  

Note: If there is no tag in the stimulation protocol, a tag will be 
automatically generated at each repetition of Lane A. To prevent 
excessive size of output files, limit the tag rate to 50 Hz.  

 

4.1.2. Stimulation Protocol Generation 

A stimulation protocol should have four goals: 

1. Maximize the efficacy, or capture, of the stimulus. 

2. Minimize the damage to the cells. 

3. Minimize the damage to the electrodes. 
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4. Minimize the stimulation artifact. 

Cell damage can result from high charge injection or charge density, while damage to the electrodes is 

caused by electrolysis. For microelectrodes of this size, electrode damage is more likely than cell damage. 

These risks and the stimulus artifact increase with the length of stimulation, but can be significantly reduced by 

using a charge-balanced stimulus shape (biphasic) and the Stimulation Artifact Eliminator block. The 

recommended Neural Stimulation block and Cardiac Pacing Stimulation block contain these features. In 

general, choosing the smallest charge-balanced, biphasic, voltage-controlled pulse with an effective capture 

rate is recommended.  

(Refer to Wagenaar et al. for an in-depth discussion of stimulus waveform shape: Wagenaar, DA, Pine, J, and 

Potter, SM. Effective parameters for stimulation of dissociated cultures using multi-electrode arrays. J. 

Neurosci. Methods. 138(1-2), 27-37 (2004)). 

To evoke activity from neuronal cultures, the Neural Stimulation Block is recommended. This block contains an 

Electrical Stimulation Tag, a Biphasic Stimulation, and a Stimulation Artifact Eliminator optimized for neural 

cultures. The most important parameter for modulating the stimulus efficacy is the Stimulus Duration. A typical 

value is 0.2-4 ms for standard electrodes, or 0.2-1 ms if using the dedicated stimulation electrode on an E-

Stim+ Classic MEA48 plate. Use a duration less than 0.5 ms for the best artifact elimination. 

To evoke activity from cardiac cultures, the Cardiac Stimulation Block is recommended. This block contains an 

Electrical Stimulation Tag, a Biphasic Stimulation, and a Stimulation Artifact Eliminator optimized for cardiac 

cultures. The most important parameters for modulating the stimulus efficacy are the Stimulus Duration and the 

number of stimulating electrodes. When using E-Stim+ Classic MEA 48, CytoView MEA 24, or BioCircuit 

MEA 24 plates, the stimulation paddle is typically used with a duration of 0.2-1 ms. For all other plates, 

microelectrode stimulation with a duration of 1-4 ms is typically used, stimulating with 2-4 adjacent 

electrodes. It is recommended to start with the shortest duration and fewest electrodes and increase until 

consistent capture is achieved (see recommended workflow in Section 4.1.3). 

Note: The Neural Stimulation and Cardiac Pacing Stimulation blocks already contain a stimulation time tag. 

Do not place an Electrical Stimulation Tag block directly in front of these blocks, or the built-in artifact 

elimination will not work. 

It is good practice to save a stimulation protocol for future reference after the pattern is completed and the 

electrodes are selected. Save stimulation protocols using File → Save Stim Waveform. Open with File → 

Open Stim Waveform. 

To build an electrical stimulation pattern: 

1. Select Electrical in the Stimulation Type drop-down menu. 

2. Click and drag a block into the desired stimulation lane. A gray bar appears in the lane indicating 

where a block will be dropped.  

3. Double-click a block in a stimulation lane to change its settings. 

Note: Use the shortest duration stimulus that is effective in order to minimize the stimulation artifact. 

To copy a block from a stimulation lane: 
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1. Right-click on the block and select Copy Pulse. 

2. Right-click on the stimulation lane and choose Paste Pulse.  

To delete a block from a stimulation lane: 

1. Right-click on the block and select Delete Pulse.  

Note: A Loop Container provides the option of deleting the loop and its contents or just the loop. 

To clear a stimulation lane: 

1. Right-click on the lane and select Clear. 

 

To specify how often to apply the stimulation: 

1. Select an option from the Stimulate drop-down menu in the Global Repeat Settings bar. 

To assign a stimulation lane to one or more electrodes: 

1. Select the plate type from the drop-down menu above the Electrode Selector in Stimulation Studio. 

2. Click on the desired stimulation electrodes in the electrode selector to the right of the plate map. 

Selected electrodes will display an “A” and are highlighted with a red square. Click All to assign all 

electrodes, or Clear to un-assign all electrodes. 

Note: E-Stim+ Classic MEA 48, CytoView MEA 24, and BioCircuit MEA 24 plates automatically 

assign electrode 41 (the dedicated stimulation electrode) when selected. 

3. Click on the desired wells that should receive the stimulation pattern. Selection is the same as the Plate 

Map Editor in Active Plate (see Section 2.2.2). 

4. Click Apply. The stimulation electrodes in the electrode selector will be applied to the wells in the 

plate map. 

Note: To remove stimulation electrodes from a well, “apply” the electrode selector to that well with no 

stimulation electrodes selected. 

 

 

 

Plate Type 

Selected Electrodes 
Selected Wells 

Apply 
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4.1.3. Example Neural Stimulation Patterns 

To build the recommended neural stimulation protocol: 

1. Select Electrical in the Stimulation Type drop-down menu. 

2. Click and drag the Neural Stimulation with Artifact Elimination block into Lane A.  

3. Optional: Double-click the block to change its settings. 

4. Select an option from the Stimulate drop-down menu in the Global Repeat Settings bar. 

Note: The Neural Stimulation block already contains a stimulation time tag. Do not add an Electrical 

Stimulation Tag block. 

 

 

To build the custom neural stimulation protocol shown below: 

1. Select Electrical in the Stimulation Type drop-down menu. 

2. Click and drag an Electrical Stimulation Tag block into Lane A. 

3. Click and drag a Loop Container into Lane A. 

4. Double-click the x2 in the upper right corner of the Loop Container and change it to x5. 

5. Click and drag the Biphasic Stimulation block into the Loop Container.  

6. Click and drag the Stimulation Artifact Eliminator block into the Loop Container behind the Biphasic 

Stimulation block. 

7. Click and drag the Delay block into the Loop Container behind the Stimulation Artifact Eliminator 

block. 

8. Select Once from the Stimulate drop-down menu in the Global Repeat Settings bar. 
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Note: Although the custom stimulation protocol described above contains a Stimulation Artifact Eliminator 

block, custom electrical stimulation waveforms will have larger artifacts because the Artifact Eliminator Data 

Processor (Section 2.3.3) only works with the Neural Stimulation and the Cardiac Pacing Stimulation blocks in 

Stimulation Studio. Axion recommends using the Cardiac Pacing Stimulation block to pace cardiomyocytes 

and the Neural Stimulation block for all other electrical stimulation applications. 

4.1.4. Cardiac Pacing Stimulus Design Workflow 

A few quick test stimuli are recommended to determine the appropriate stimulus for reliably capturing the wells 

of interest before beginning the full stimulation protocol. 

For Microelectrode stimulation, the suggested workflow is shown below. Proceed until successful capture is 

achieved at the desired maximum frequency. In general, the required stimulus depends on cell type, plating 

density/uniformity, and culture viability. Choose the lowest level stimuli that achieves complete capture at the 

highest pacing rate. 

Note: It is not possible to pace slower than the spontaneous frequency of the cardiac culture. Be sure to 

choose the pacing rate with both the control frequency and the predicted pharmaceutical effects in mind. 

When using treatments that will prolong the beat period, choose a slow pacing rate; when shortening the beat 

period, choose a faster pacing rate. 
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Stimulating using the dedicated stimulation electrode (Stimulation Paddles) on the CytoView MEA 24, E-Stim+ 

Classic MEA 48, and BioCircuit MEA 24 plates is generally more effective at capturing the network than 

stimulating through the microelectrodes. If the default parameters are not sufficient to capture the culture, 

change the stimulation by: 

1. Increase the duration and/or amplitude in small increments (0.1 ms and/or 10 µA), not to exceed 1ms 

and 100 µA  

Note: Do not exceed 30 µA for BioCircuit MEA 24 Plates.  

2. Faster pacing frequencies may require larger stimulation parameters than slower pacing frequencies. If 

the stimulation still does not capture the culture, change the pacing frequency to a frequency closer to the 

culture’s spontaneous beat rate. 

 

As the duration and amplitude of stimulation are increased, stimulation artifact may begin to increase. It is 

important to make sure the beats detected by AxIS Navigator are true beats and not stimulation artifact. Check 

the Conduction Plot in the Cardiac Beat Plots panel to make sure the beat propagation is in the physiological 

range 2-10 ms. If the conduction plot shows propagation less than 1.5 ms along with an unusual pattern, the 

Cardiac Beat Detector is most likely detecting simultaneous stimulation artifact rather than propagation across 

the syncytium. Alternatively, use the Stimulation Inspector (Section 2.3.4) to determine the size of the 

stimulation artifacts. Increase the Beat Detection Threshold to prevent detection of stimulation artifacts as beats.  

 

 

4.2. OPTICAL STIMULATION  

Axion designed the Lumos™ optical stimulator for artifact-free light stimulation. Cell cultures must be 

engineered with opsins in order to become light-sensitive. When integrated with AxIS Navigator, the Lumos 

can independently stimulate each well with up to four wavelengths of light. The optical stimulation interface in 

Stimulation Studio is laid out similarly to the electrical stimulation interface.  

True Beats Stimulation Artifacts 
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For data acquisition with optical stimulation: 

1. Build the stimulation protocol according to Section 4.2.2.  

2. Start recording data according to Section 3.3, by selecting the desired configuration as outlined 

below: 

a. Cardiac Real-Time → Field Potentials Paced, LEAP Paced, or Contractility Paced plus 

Viability if needed.  

b. Neural Real-Time → Optically Evoked plus Viability if needed.  

3. Click the Start button to begin the stimulation protocol manually. Click again to stop. 

Note: If Once is selected in the Global Repeat Settings, the stimulation protocol may be started 

automatically by the Scheduled Recording Setup panel(Section 2.6.2). 

For data analysis with optical stimulation: 

1. Analyze data according to Section 9.5, selecting the Field Potentials Paced, LEAP Paced, or 

Contractility Paced or Optically Evoked configuration. 

Note: See the ‘Neural Metric Tool’ for evoked activity analysis options for neural analysis. 

 

 

 

Stimulation Blocks Compiled Pattern View 

Global Repeat Settings 

LED Selector 

Stimulation Lanes 



AxIS Navigator 3.9 User Guide 

[67]  

 

4.2.1. Optical Stimulation Blocks 

The optical stimulation blocks are: 

Block Icon Description 

Optical Pulse 

Stimulation 

(On) 

 

Applies a constant intensity of light for a set duration. Set intensity 

and duration with Intensity and Stimulus Duration in the Pulse Settings 

dialog. 

Optical Pulse 

Stimulation 

(Off) 

 
 

Applies a set duration of no light. Use as a wait period. Set duration 

with Stimulus Duration in Pulse Settings dialog. 

Optical Ramp 

Stimulation 

 
 

Applies a linearly increasing intensity for the duration of the pulse. 

Set the starting and ending intensity and duration with Starting 

Intensity, Ending Intensity, and Ramp Duration in the Ramp Settings 

dialog. 

Loop Container 

 
 

Repeats any blocks contained within a set number of times. Double-

click the repeat number (xN) in the top right corner of the block to set 

the number of times. 

Optical 

Stimulation Tag 

 

Set the location of a “tag” or time stamped note to indicate a 

stimulation occurred. Tags are useful for visualization and analysis of 

evoked activity. Only one tag block can be set per stimulation 

protocol, so tags cannot be assigned to multiple lanes of stimulation.  

Note: If no tag is manually set, a tag will be automatically generated 
at each repetition of Lane A. To prevent excessive size of output files, 
limit the tag rate to 50 Hz. 

 

4.2.2. Stimulation Protocol Generation 

Stimulation Studio allows the user to generate multiple “lanes” of optical stimulation patterns. Each stimulation 

lane may be assigned only one wavelength but multiple stimulation lanes may be assigned the same 

wavelength. Each well may be assigned any combination of wavelengths, but no two stimulation lanes of the 

same wavelength may be assigned to the same well. 

Warning: Running LEDs at high output intensity settings with high duty cycles for extended periods of time will 

result in significant build-up of radiated heat. Take special care not to overheat objects lying directly 

underneath the Lumos, such as a culture plate, the Maestro, or the Lumos stand. If elevated temperatures are 
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maintained, AxIS Navigator will turn the Lumos off, but it’s possible to reach temperatures that could be 

damaging to cell cultures before then. 

It is good practice to save a stimulation protocol for future reference, after the pattern is completed and the 

wells are selected. Save stimulation protocols using File → Save Stim Waveform. Open with File → Open 

Stim Waveform. 

To build an optical stimulation pattern: 

1. Select Optical in the Stimulation Type drop-down menu. 

2. Select the Lumos model from the drop-down menu above the plate map. 

3. Click and drag a block into the desired stimulation lane. A gray bar appears in the lane indicating 

where a block will be dropped.  

4. Double-click a block in a stimulation lane to change its settings. 

5. Click on the desired wavelength for the lane. 

6. (optional) Type a name for the lane in the space beside the lane letter.  

To copy a block from a stimulation lane: 

3. Right-click on the block and select Copy Pulse. 

4. Right-click on the stimulation lane and choose Paste Pulse.  

To delete a block from a stimulation lane: 

2. Right-click on the block and select Delete Pulse.  

Note: A Loop Container provides the option of deleting the loop and its contents or just the loop. 

To add new stimulation lanes: 

1. Click the Add Lane button.   

To copy a stimulation lane: 

1. Right-click on the lane and select Copy Lane. 

2. Right-click on a lane and select Paste Lane to create an identical new lane. 

3. Right-click on a lane and select Paste Lane Contents to paste the contents of the copied lane to the 

current lane. 

To clear a stimulation lane: 

2. Right-click on the lane and select Clear. 

To delete a stimulation lane: 

1. Click on the red X ( ) in the top right corner of the lane. 

To hide a stimulation lane: 
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1. Click on the eye icon ( ) in the bottom right corner of the stimulation lane. 

Note: Hiding a lane will only prevent it from being seen in the compiled pattern view, not disable its 

activity during stimulation. 

 

To specify how often to apply the stimulation: 

1. Select an option from the Stimulate drop-down menu in the Global Repeat Settings bar. 

Note: The Global Repeat Settings bar applies to all stimulation lanes defined in the stimulus. To set a 

distinct frequency or number of repetitions across different lanes, use the repeat block in each individual 

lane. 

To assign a stimulation lane to one or more wells: 

1. Click on the stimulation lane to select it. 

2. Click on the desired well(s) in the plate map in Stimulation Studio to apply the lane to that well. 

Selection is the same as the Plate Map Editor in Active Plate (See Section 2.2.2). 

Note: When selected the lane color will become active with the lane letter inside.  

Multiple stimulation lanes of the same wavelength can be defined, but each well may only be assigned a 

single lane for each wavelength. Multiple stimulation lanes, each having a unique color, can be applied to the 

same collection of wells. Right-click on the LED Selector to quickly clear previous well assignments. 

 

 

20 Hz pulse train at 75% 

10 Hz pulse train at 40% 

Constant orange light at 20% 

Constant green light at 5% 

Tag Marker 

Right-click Menu 

Letters indicate Lane 
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4.2.3. Example Stimulation Pattern 

A basic example of a periodic blue light stimulus is shown below.  The pulse block is set to 5 ms duration at 

25% intensity. The lane is designated for the blue LED and is assigned to each well of the plate.  The global 

repeat bar specifies a 1 Hz frequency. This stimulation could be used to pace a spontaneously beating 

cardiac culture with a periodic blue light stimulus.  

 

Use 

the 

following steps to recreate the example stimulus above: 

1. Select Optical from the Stimulation Type drop-down menu. 

2. Click and drag an Optical Stimulation Tag block into Lane A. 

3. Click and drag an Optical Ramp Stimulation block into Lane A. 

Note: Using a ramp is recommended, but not required. Although optical stimulation artifacts are rare, 

using a ramp before the pulse helps minimize any potential artifacts. The Ending Intensity of the ramp 

should match the pulse intensity. 

4. Double-click the Optical Ramp Stimulation block to set the Ending Intensity to 25% and Ramp 

Duration to 2 ms. 

5. Click and drag an Optical Pulse Stimulation block into Lane A. 

6. Double-click the Optical Pulse Stimulation block to set the Intensity to 25% and Stimulus Duration to 5 

ms. 

7. Click the blue button to the left of Lane A to specify the wavelength as 475 nm (blue). 

8. Click on the * in the upper left corner of the plate map to assign the stimulus pattern in Lane A to all 

wells in the plate. 

9. Select until stopped in the Stimulate drop-down. Set every to 1 second(s). 

 

Wavelength Select 
Well Select 

Add Lane 

Start 

stimulat
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4.3. EVALUATING CARDIAC STIMULATION CAPTURE 

Effective capture means each stimulation pulse elicits a beat in each of the stimulated wells. This is the most 

critical factor when determining stimulation parameters. If a stimulus does not capture the majority of wells, a 

stronger stimulus should be used (see Section 4.1.4 for recommendations). Generally, the “weakest” stimulus 

that consistently captures each well should be used. Stronger stimuli can affect the ability to record the sodium 

spike, due to the larger stimulation artifact.  

4.3.1. Field Potentials and LEAP Beat Capture 

For voltage recordings using Cardiac: Field Potentials or Cardiac: LEAP Acquisition Settings, the Beat Periods 

plot in the Cardiac Beat Plots panel, the Continuous Waveform Plots panel, and the Activity Map panel are all 

useful in diagnosing whether a well has been captured.  

In the Beat Periods plot, the spontaneous beat period will change to match the paced beat period.  

 

Capture can also be evaluated using the Stimulation Inspector. To add a stimulation inspector, right click on 

the Artifact Eliminator and select Add Processing → Stimulation Inspector (shown in orange in table below). 

The white triangle at the top indicates the timing of the stimulus. An evoked beat typically follows 2-5 ms after 

the stimulus. The following table illustrates how various capture conditions appear in the Beat Period Plot and 

Stimulation Inspector panel for pacing at 1 Hz: 

Status Beat Period Plot Stimulation Inspector on Artifact 

Eliminator 

Full Capture  

All stimuli elicit beats 

 

 
 

 
 

Spontaneous Beat Period Paced Beat Period 

Spontaneous Beat Period 

Paced Beat Period 

Evoked Beat 
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Partial Capture 

Some stimuli elicit beats 

 

 

 

 

No Capture 

No stimuli elicit beats 

 

 

Note: The Stimulation Inspector displays voltage data, therefore is useful for evaluating capture in Cardiac 

Field Potentials Paced and Cardiac LEAP Paced configurations. It should not be applied to cardiac contractility 

signals. 

Capture can also be assessed using the Activity Map with the source set to Beat Rate. Set the scale to the 

target paced beat rate. When the beat rate of each electrode is equal to the pacing rate, the well has been 

successfully paced. In order to use the Beat Periods plot and Activity Map to evaluate capture, ensure the Beat 

Detector is capturing true beats, not stimulation artifact (Section 2.3.7). 

 

 

4.3.2. Contractility Beat Capture 

Successful capture for contractility can be assessed in the Continuous Waveform Plots panel. Set the Time 

Scale to a value where the pacing rate can be evaluated by counting the number of evoked beats.  If the 

number of beats doesn’t agree with the stimulation rate, effective capture is not being achieved. The following 

table illustrates how various capture conditions for contractility appear in the Continuous Waveform Plots 

panel for pacing at 2 Hz: 

 

 

 

 

Evoked Beat (faded) 

Failed 

Failed (bold) 
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Status Scale set to1s/div Scale set to 500ms/div 

Full Capture  

All stimuli elicit beats 

 

2 contractility beats per div;  

10 beats total in 5 sec window  

 

 
 

1 contractility beat per div; 

5 beats total in 2.5 sec window  

 

 

Partial Capture 

Some stimuli elicit beats 

 

 

 

 

Alternatively, the Maestro trace can be plotted simultaneously with the Artifact Eliminator trace to show the 

stimulation artifact with respect to the contractility beat. In the example below, it can be easily seen that only 

some of the stimuli are evoking a beat, which is partial capture.  

 

 

 

 

 

 

 

4.4. EVALUATING NEURAL STIMULATION CAPTURE 

Neural stimulation capture can be viewed in the Spike Plots panel with a combination of Electrical or Optical 

Stimulation Tags and the Stimulation Inspector data processor.  

The stimulation tags synchronize the recorded electrophysiological activity with the stimulation pattern. The 

timing of each stimulation is displayed alongside the recorded electrophysiological data, providing instant 

feedback on a successful stimulus.  The tags are displayed in the raster plot as inverted white triangles, 

corresponding to the tags defined in Stimulation Studio.  

Missed Capture 

Capture 

Stimulation Artifact 

Missed Capture 

Capture 
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The Stimulation Inspector data processor plots the continuous voltage data from before and after an Electrical 

or Optical Stimulation Tag to the Spike Plots panel. The waveform plots overlay with the brightest trace 

representing the most recent tag. This provides a close look at data near a Tag to evaluate artifact elimination 

and cell response to the stimulation. See Section 2.3.4 for more information on the Stimulation Inspector. 

  

  

 

 

Tag 
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CHAPTER 5. LOCAL EXTRACELLULAR ACTION POTENTIAL (LEAP) 

The Local Extracellular Action Potential (LEAP) assay allows acquisition of extracellular action potential 

waveforms from cardiomyocytes on Axion’s MEA plates. Acquiring LEAP signals requires a proprietary 

induction procedure that increases the coupling between the cells and the electrodes. Unlike traditional patch 

clamp or voltage sensitive dye techniques, LEAP signals are stable for 10-20 minutes after induction and can 

be recorded from intact syncytia without altering spontaneous activity, compromising membrane integrity, or 

requiring addition of labels.  

5.1. LEAP BACKGROUND  

In a typical cardiomyocyte-MEA assay, field potential signals are detected from cells near the electrodes, 

which are the result of the cardiac action potential propagating across the array, similar to the way in which 

the ECG arises from propagation of the cardiac action potential across the heart. The field potential signal has 

always been qualitatively similar to the ECG waveform.  However, unlike a surface ECG, the cardiomyocyte 

syncytium is in direct contact with the electrode.  The LEAP assay uses proprietary techniques to enhance the 

cell-electrode coupling, enabling the electrodes to detect a Local Extracellular Action Potential (LEAP), which 

closely approximates the waveform of an intracellular action potential. 

 

The LEAP signal provides a direct mapping from field potential to action potential morphology. The LEAP 

signal is much larger than the field potential, and arrhythmic events are easily seen on the extracellular action 

potential waveform, which improves the accuracy and automation of analysis along with automatic early 

after-depolarization (EAD) detection, classification, and counting. The image below shows a clear EAD on 

each beat in the LEAP signal, with the smaller corresponding field potential deflections below. 
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The signal detected on each electrode always contains contributions from both the field potential and LEAP; 

the LEAP assay is simply a way of enhancing the cell-electrode coupling such that the relative contribution of 

the LEAP signal is much larger. As such, a variety of waveforms may be observed after inducing LEAP, as 

described in the table below: 

Waveform Description 

 

Large LEAP signal with undetectable field potential 

contribution, typically 5-10 mV in amplitude. 

 

Strong LEAP signal, but note the field potential is large enough 

to still show above the peak of the LEAP signal. These LEAP 

signals are typically 500 µV to 5 mV. With Enhance for LEAP 

on, the field potential component is removed enabling the user 

to view only the LEAP signal. 

 

No LEAP signal; LEAP induction was not successful and a field 

potential signal remains. 

 

Note: AxIS Navigator displays LEAP signals using the Enhance for LEAP option (Section 2.6.6), which 

automatically separates the LEAP and field potential and removes the field potential component of the signal, 

allowing the user to only view the LEAP signals. This enhancement is purely visual and does not affect the data 

analysis in AxIS Navigator or metric computation in the Cardiac Analysis Tool. 

5.2. DESIGNING A LEAP INDUCTION PLATE MAP 

The LEAP Setup panel is used to design a LEAP induction plate map, which specifies the wells and electrodes 

for LEAP induction.  
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Select a pattern of electrodes for LEAP induction using the Selected Electrodes: drop-down menu on the right. 

Electrodes in green will be used for LEAP induction, while electrodes in gray will not.  

Click on a well in the LEAP Well Selector to select it. Multiple wells can be selected by clicking on the column 

or row label to highlight the column or row, respectively; clicking the * in the upper left corner to select the 

entire plate; holding the Ctrl key and clicking on the desired wells; selecting two wells while holding the Shift 

key to select all of the wells between them; or by click-and-drag selecting wells in a region. 

LEAP is compatible with all plate types. However, due to differences in electrode geometry and material, the 

optimal LEAP induction protocol differs between plate types. For Classic MEA plates, choose the electrode 

pattern that is best suited for the experiment design – select All electrodes for maximal LEAP yield. With 

CytoView MEA plates, the pre-configured grid patterns in AxIS Navigator are recommended, such that LEAP 

induction occurs on every other electrode in a well. 

To record LEAP signals and field potentials simultaneously, select a pattern of electrodes that leaves some 

electrodes un-induced for field potential recordings. 

5.3. LEAP ACQUISITION AND ANALYSIS TUTORIAL 

To acquire LEAP signals: 

1. Set up the Maestro for data acquisition as described in section 3.3. 

Select Electrode Pattern 

LEAP Well Selector 

LEAP Setup 

Start Induction 

Clear LEAP Tags 
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2. Right-click on the Maestro Pro or Maestro Edge stream and select Configuration → Cardiac Real-

Time → LEAP.  

Note: Use the Cardiac Real-Time → LEAP Paced configuration when pacing electrically or optically. 

Applying the LEAP configuration will cause the LEAP Setup panel to appear. 

3. Design a LEAP induction plate map in the LEAP Setup panel by selecting a pattern of electrodes using 

the drop-down menu on the right to be applied to the wells selected using the LEAP Well Selector in 

the center (Section 5.2). 

4. Click Start Induction to initiate LEAP induction. 

Note: LEAP induction takes ~10 minutes, during which file playback and recording are disabled. 

When LEAP induction is complete, playback will begin automatically. 

5. Press Record to save a .raw file with the LEAP signals.  

WARNING: LEAP signals last from 20 min up to a few hours, so be sure to press record after 

induction to save the LEAP data. 

 

After inducing LEAP, tags are added to the .raw file indicating which electrodes were selected for LEAP 

induction. LEAP tags are retained and included in all subsequent recordings using any Cardiac Acquisition 

Settings so that the LEAP signals are analyzed correctly. To remove LEAP tags from subsequent recordings, 

select Clear LEAP Tags in the LEAP Setup panel before recording the next .raw file. 

Note: LEAP tags are cleared automatically when a new plate is docked in the Maestro. 

To analyze LEAP signals: 

1. Follow the steps for data analysis as described in Section 9.5, using Configuration → LEAP to save a 

Cardiac Statistics Compiler Advanced Metrics .csv file. 

2. Load the .raw and .csv files into the Cardiac Analysis Tool to generate LEAP metrics, such as Action 

Potential Duration (APD) 30%, 50%, and 90% repolarization. 

 

The LEAP analysis configuration is used for analysis even when only a subset of electrodes were selected for 

LEAP induction. The same Cardiac Beat Detector analyzes both LEAP signals and field potential signals, 

depending on where LEAP is induced.  

In the Continuous Waveform Plots, an inverted gray triangle in the upper right corner indicates LEAP was 

induced on that electrode. 

 

 

LEAP induced 



AxIS Navigator 3.9 User Guide 

[79]  

 

The Cardiac Beat Detector applies a LEAP beat detection algorithm to data acquired using Cardiac: LEAP 

Acquisition Settings for electrodes that are LEAP induced/tagged or have spontaneous LEAP waveforms. It 

applies the field potential beat detection criteria (Section 2.3.7) to all other electrodes. For data recorded 

using Cardiac: Spontaneous or Cardiac: Broadband Acquisition Settings, the field potential beat detection 

criteria is applied to all electrodes except those selected for LEAP induction. In the Cardiac Beat Plots, an 

inverted green triangle indicates LEAP was induced on the electrode and the beats on that electrode are 

detected as LEAP beats. An inverted gray triangle in the upper right corner indicates LEAP was induced on the 

electrode, but no LEAP beats are detected.  

 

5.3.1. Adding or Removing LEAP Tags from Files 

LEAP is not a mathematical change to the acquired signal, so previously recorded field potentials cannot be 

transformed into LEAP signals. LEAP induction is required to increase cell-electrode coupling and change the 

acquired signal. 

In some instances, it may be desirable to add or remove LEAP tags from previously recorded LEAP data in 

order to change the way the data is analyzed in the Cardiac Beat Detector. LEAP tags are initially added to 

the .raw file to indicate which electrodes were used for LEAP induction. Once a new plate is inserted into the 

Maestro, recordings will no longer retain the LEAP tags. For example, if a LEAP recording is performed at 

10:00 am, then the plate is returned to the incubator while other plates are recorded, a subsequent recording 

at 12:00 pm will not contain the LEAP tags required for analysis of LEAP signals, so it may be desirable to add 

LEAP tags for analysis. 

To add LEAP tags to a .raw file: 

1. Load the .raw file into AxIS Navigator by selecting File → Open Recording(s)…. 

2. Click the thumbnail to select the LEAP Setup panel. 

3. Click the Lock icon to unlock the LEAP induction plate map for editing. 

4. Click the folder icon to import a LEAP induction plate map from a different (e.g. earlier) .raw file. 

– OR –  

5. Select the wells where LEAP was induced from the LEAP well selector in the center and the LEAP 

electrode pattern from the Selected Electrodes: drop-down menu.  

6. (Optional) Use the Induction Date: menu to specify the original date and time of LEAP induction. 

7. Click the lock to prevent further changes to the LEAP induction plate map. 

No LEAP beats detected 

LEAP beats detected 
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Conversely, to analyze field potentials from electrodes that were initially selected for LEAP induction, it is 

possible to remove the LEAP tags from the .raw file.  

Note: If a grid of electrodes was used for LEAP, the Cardiac Beat Detector automatically applies LEAP beat 

detection to LEAP induced/tagged electrodes and field potential beat detection to all other electrodes. It is not 

necessary to remove LEAP tags from the .raw file unless you want to analyze field potentials from electrodes 

that were initially tagged as LEAP induced. 

To remove LEAP tags from a .raw file: 

1. Load the .raw file into AxIS Navigator by selecting File → Open Recording(s)…. 

2. Click the thumbnail to select the LEAP Setup panel. 

3. Click the Lock icon to unlock the LEAP induction plate map for editing. 

4. Click Clear LEAP Tags to deselect all wells in the LEAP Well Selector, or deselect a subset of wells by 

clicking on a single well or using the *, row label, column label, Ctrl, or Shift keys. 

5. Click the lock to prevent further changes to the LEAP induction plate map. 

Note: There is an option in the Cardiac Analysis Tool to ignore the LEAP tags and analyze field potentials 

only, so it is not necessary to remove the LEAP tags from the .raw file in AxIS Navigator in order to analyze 

field potentials in the Cardiac Analysis Tool. Please see the Cardiac Analysis Tool for details. 

LEAP Well Selector 
LEAP Electrode Pattern 

Unlock to Edit 

Import LEAP tags 

Induction Date/Time 
Clear LEAP Tags 
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5.4. EXAMPLE LEAP EXPERIMENT DESIGN 

The LEAP assay provides complementary information to the Maestro field potential assay, such that it is helpful 

to measure both signals from the same plate.  An example experiment design is illustrated below with (1) a 

baseline field potential (FP) recording, (2) a post-dose FP recording, and (3) a post-dose LEAP recording 

following LEAP induction. In this experiment design, the LEAP signal enables automated EAD detection and 

quantification of action potential morphology.  For applications in characterizing stem cell derived 

cardiomyocytes, the user may elect to skip (2), and instead record activity at multiple stages in development. 

 

The workflow for this experiment is described below: 

1. Place the MEA plate in the Maestro and allow the cells to equilibrate for 10-20 minutes. 

2. Select Configuration → Cardiac Real-Time → Spontaneous. 

3. Record a baseline .raw file (5-30 minute recording is recommended). 

4. Add compounds to the MEA plate. 

5. Return the MEA plate to the Maestro and record a post-dose field potential recording (5-30 minute 

recording is recommended, at post-dose time point of interest). 

6. Select Configuration → Cardiac Real-Time → LEAP. 

7. Induce LEAP. 

8. Immediately record a post-dose LEAP recording. 

5.5. FAQ 

1. How does LEAP work? 

The LEAP signal arises from an increased coupling of the cardiomyocytes to the electrodes on an Axion 

MEA plate following the LEAP induction process.  The strength and shape of the LEAP waveform is 

determined by the cell-electrode coupling and the action potential morphology of the cells local to the 

electrode. 

2. Is LEAP mathematical magic? 

No. As stated in FAQ #1, LEAP is actually a change in the signal recorded by the electrodes resulting 

from an increase in cell-electrode coupling, rather than a result of signal manipulation.  However, AxIS 

Navigator does employ optional filtering techniques (“Enhance for LEAP”) to suppress the underlying field 

potential that remains from nearby cells for optimal visualization of LEAP signals. 



Local Extracellular Action Potential (LEAP) 

[82]  

 

3. Can LEAP be applied to old data?  

No. LEAP induction is required to increase cell-electrode coupling and, thus, change the acquired signal.  

4. Is LEAP compatible with all plate types? 

Yes.  However, due to differences in electrode geometry and material, the optimal LEAP induction 

protocol differs between plate types. For Classic MEA plates, choose the electrode pattern that is best 

suited for your experiment design.  With CytoView MEA plates, we recommend using the pre-configured 

grid patterns in AxIS Navigator, such that LEAP induction occurs on every other electrode in a well. 

5. Does LEAP work for all cell types?  

LEAP signals have been successfully recorded from most commercially-available iPSC-derived 

cardiomyocytes and multiple “home-grown” cardiomyocyte lines. Cells with beat period < 1s may have 

reduced LEAP yield, as the frequent contractions release the syncytium from the increased cell-electrode 

coupling. For these cells, we suggest performing LEAP induction at a slightly lower temperature (~ 35oC) 

to reduce the beat period. LEAP is not compatible with neuronal assays. 

6. Can I perform LEAP on the original Maestro?  

No. The BioCore v4 chip in the Maestro Pro and Edge enables LEAP induction and signal acquisition. 

7. Will LEAP work with poor cell coverage? 

Weak field potential signals indicate poor cell coverage over the electrode(s). Without sufficient cell 

coverage, it is difficult to increase cell-electrode coupling and thus LEAP yield may be limited.  In some 

cases, LEAP induction may boost signal strength for experiments with low amplitude field potential signals. 

8. Why do LEAP amplitudes vary?  

LEAP amplitudes represent the degree of cell-electrode coupling achieved by LEAP induction, with larger 

signals representing stronger coupling.  

9. How long does LEAP last?  

LEAP signals are typically stable for 10-20 minutes, but may last for hours. LEAP signals will decay over 

long periods of time as the mechanical beating of the cells returns the cell-electrode coupling to field 

potential levels. So, be sure to record your data immediately after LEAP induction to avoid LEAP data loss.  

10. Can LEAP be repeated on the same plate?  

LEAP can be repeated on the same plate, but typically not on the same electrode(s). LEAP induction is 

more effective the first time and efficacy decreases with subsequent induction. 

11. Why do some LEAPs have a superimposed field potential feature?  

Axion’s MEA plates are always sampling the field potential signal from cells near the electrode.  LEAP 

induction increases the cell-electrode coupling, providing the LEAP signal from only the cells directly 

attached to the electrode.  So, it is possible to see features of the field potential signal and LEAP signal on 

the same electrode.  The optional “Enhance for LEAP” feature (see FAQ #2) reduces the field potential 

component of the signal recorded at the electrode for visual purposes only.   

12. Is LEAP compatible with cardiomyocyte pacing? 

Yes.  The standard pacing tools available in AxIS Navigator may be used with LEAP and field potential 

signals. 

13. Will I see a LEAP signal on every electrode? 

Even if every electrode is selected for LEAP induction, it is unlikely that you will see a LEAP signal on every 

electrode. LEAP yield depends on a variety of factors, including cell coverage, cell density, beat rate, and 
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cell type. In general, we expect to see LEAP signals in 80-100% of wells when all electrodes are selected 

for induction.  

14. Can LEAP signals be compared across electrodes in a well and between wells? 

Yes.  As with any assay, the user should quantify the degree to which biological variability may impact 

certain comparisons.  For example, minor differences in LEAP signal shape on neighboring electrodes 

may be due to the distinct populations of cardiomyocytes and the cell-electrode coupling present on each 

electrode.  Good well-to-well reliability of cardiomyocyte electrophysiology can easily support 

comparison of LEAP signals across wells. 

15. Is LEAP the same as patch clamp? 

No.  The patch clamp technique relies on perforating the cell membrane to gain access to the 

transmembrane voltage and allow interrogation with current or voltage clamp protocols.  Also, patch 

clamp typically requires isolating single cells.  LEAP instead measures an extracellular action potential 

without disrupting the cell membrane from a local collection of cells within an intact, functional syncytium. 
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CHAPTER 6. CONTRACTILITY 

When cardiomyocytes are plated over an array of microelectrodes, they form a spontaneously beating 

syncytium. Every beat is characterized by a propagating electrical impulse, measured by the field potential or 

action potential, that triggers a mechanical contraction of the heart muscle. As the cells contract and relax over 

an array of electrodes, cells change shape and thus change the coverage over the electrode. These rhythmic 

changes with each beat can be detected by impedance measurement technology, and represent the 

contractility of the cardiomyocytes. The Maestro offers high resolution contractility from an array of 

microelectrodes, providing a rich detailed map of contraction across the entire syncytium.  

 

6.1. CONTRACTILITY BACKGROUND 

Impedance describes the barrier to current flow out of the microelectrodes. Impedance varies with cell 

coverage, cell shape, and with the contraction and relaxation of the cells over the electrode. Contractility is 

the use of impedance technology to measure the small rhythmic changes in cardiomyocyte shape that occur 

with each beat.  

 

 

The contractility signal detected on each electrode represents the local mechanical contraction and relaxation 

of the syncytium.  As the electrical impulse (field potential) propagates and the cells contract and relax, they 

pull against each other and the attachment sites in the well. Thus, within a syncytium, some cells are 

contracting while others are relaxing, resulting in positive, negative, and biphasic contractility signals 

depending on the location in the culture. Example waveforms are illustrated below:  
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Waveform Description 

 

Positive contractility waveform represents an increase in 

impedance on the electrode, likely caused by contraction 

and relaxation of the cardiomyocytes over the electrode  

 

Negative contractility waveform represents a decrease in 

impedance on the electrode, which may be the result of 

local cardiomyocytes being stretched by the contraction of 

neighboring cardiomyocytes   

 

Biphasic contractility waveform represents both a 

decrease and increase in impedance on the electrode, 

which may be due to cardiomyocytes being stretched and 

then contracting over the electrode  

 

Triphasic contractility waveform represents both a 

decrease and increase in impedance on the electrode, 

which may be the result of cardiomyocytes being stretched 

by neighboring cardiomyocytes before and after the peak 

contraction of the local cardiomyocytes 

 

6.2. CONTRACTILITY ACQUISITION AND ANALYSIS TUTORIAL 

To acquire contractility signals: 

Follow the steps for data acquisition as described in Section 3.3, selecting Configuration → Cardiac Real-

Time → Contractility to appropriately configure the hardware and software to record contractility signals. 
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To analyze Contractility signals: 

Follow the steps for data analysis as described in Section 9.5, using Configuration → Contractility to save a 

Cardiac Statistics Compiler Advanced Metrics .csv file. LEAP and field potential signals may be recorded in 

series with contractility signals, by selecting a different Cardiac Real-Time configuration. 

For more in-depth analysis of Contractility signals, .raw Contractility files can be imported and analyzed with 

the AxIS Metric Plotting Tool. This can be useful if field potential amplitudes are weak (<250 µV) or to provide 

additional Contractility metrics, such as Beat Width and Composite Beat Amplitude. 

6.3. FAQ 

1. How does contractility work? 

Contractility uses impedance technology to measure the beating of cardiomyocytes. As the cells contract 

and relax over an array of electrodes, the cells change shape and, thus, change the coverage over the 

electrodes. These changes are detected as rhythmic changes in impedance and represent the contractility 

of the cardiomyocytes. 

2. How is contractility different on the Maestro? 

The Maestro offers high resolution array-based contractility. The Maestro samples from an array of 

microelectrodes to provide local measures of cardiomyocyte contractility with high spatial resolution from 

all across the culture. AxIS Navigator provides both a local contractility Beat Amplitude on each 

electrode, as well as well-wide composite contractility endpoints, including Composite Beat Amplitude, 

Beat Period, and Excitation-Contraction Delay, to describe average contractility behavior in each well.  In 

contrast, most electrode-based impedance systems rely on 1-2 larger electrodes to provide a single 

measure from each well. 

3. Why do contractility shapes and amplitudes vary?  

At any given moment, some regions of the syncytium are mechanically contracting, while others are being 

stretched. Array-based contractility allows the user to identify how contractility varies across the syncytium 

and to track these local changes in contractility. In addition, these mechanical patterns can be represented 

as a Contractility Map, where the relative size of each orange circle in the array indicates whether the 

local cells are contracting or being stretched.  

4. Will contractility work with poor cell coverage? 

Yes. Array-based contractility is robust against poor cell coverage and allows the user to track local 

changes in contractility even if the other electrodes in the well are not well covered.  

5. Can contractility be measured from 3D cardiac constructs? 

Yes. Array-based contractility enables advanced applications, such as measuring the contractility from 

several 3D spheroids in the same well. A large electrode, as used by other systems, would smear these 

signals or not detect them at all. 

6. Is contractility compatible with all plate types? 

No. Contractility is compatible with premium CytoView MEA plates, which offer low impedance PEDOT 

microelectrodes. Contractility is not compatible with higher impedance Classic and BioCircuit MEA plates.   
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7. Does contractility work for all cell types?  

Contractility has been evaluated with most commercially-available iPSC-derived cardiomyocytes and 

multiple “home-grown” cardiomyocyte lines. Contractility requires cells to be mechanically active and 

cover at least one electrode. 

8. Can I record contractility on the original Maestro?  

No. The Maestro Pro or Edge are required for contractility. 

9. Is contractility compatible with pacing?  

Yes. The standard pacing tools available in AxIS Navigator may be used with contractility. For best 

results, use the Contractility Paced configuration and a dedicated stimulation electrode (paddle). 

10. Can contractility be measured simultaneously with field potentials?   

The Maestro contractility assay provides excitation tracking based on the underlying field potential, 

measured from the same electrodes. Endpoints from the field potential related to excitation, such as Beat 

Period and Conduction, are tracked simultaneously with contractility endpoints. However, contractility 

does not allow for t-wave detection for field potential duration.   

11. Why do I see contractility signals in the Continuous Waveform Plots but not in the Cardiac Beat Plots? 

Contractility uses the highly precise excitation timing from the underlying field potential to segment 

contractility beats. If the field potential amplitudes are too weak (< 250 µV), contractility beats will not be 

detected. If contractility beats are not detected, you can verify the field potential amplitude by applying 

the Field Potential Configuration (right click on the Maestro and select Configuration → Cardiac Offline 

→ Field Potential). For commercially available cardiomyocytes, field potential amplitude increases as the 

cells attach to the electrodes, typically exceeding the detection threshold by DIV 3.   

12. Is contractility compatible with LEAP?   

Contractility and LEAP can be recorded in the same experiment, but not simultaneously. For best results, 

contractility measurements should be made prior to LEAP induction, as LEAP changes the cell-electrode 

coupling.  
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CHAPTER 7. NEURAL BROADBAND AND LOCAL FIELD POTENTIALS 

Local field potential (LFP), broadly, refers to the electrical potential measured in the extracellular space near a 

neuron. Variation in local field potential is thought to largely be driven by a spatial summation of post-synaptic 

potentials. Slow oscillations of local field potentials in intact brains are often colloquially referred to as brain 

waves, and the frequency content of these waves is associated with distinct behavioral states in vivo such as 

focus or sleep. These low frequency signals may also be observed in vitro, where the oscillatory patterns and 

frequency content of discrete LFP events (hereafter referred to as LFPs) may provide insight into the excitatory-

inhibitory balance of the network and the evolving complexity of the network during maturation. With the 

Neural: Broadband mode, the Maestro makes it easy to gather low frequency LFPs and perform high fidelity 

spike time identification simultaneously, providing another set of metrics for investigators characterizing in vitro 

neuronal models.    

7.1. NEURAL BROADBAND MODE 

While Configuration → Neural Real-Time → Spontaneous has the best signal to noise ratio for spike 

detection, users who wish to capture low frequency LFPs alongside spikes may use the Broadband 

Spontaneous configuration. Neural: Broadband mode allows the Maestro to record continuous voltage data 

across a wide band of frequencies (1 Hz – 5 kHz) for the simultaneous recording of spikes and LFPs. The 

Broadband Processor allows the user to easily separate the broadband data into its high frequency content for 

spike detection and low frequency content for LFP detection and possible spectral analysis in post processing. 

The Broadband Processor produces an AxIS .raw file containing two continuous voltage datasets. The high 

frequency dataset (200 Hz – 5 kHz) is produced by a 2nd order digital Butterworth bandpass filter, whereas 

the low frequency dataset (0.1 Hz – 50 Hz) is produced by a median filter and downsampler at 100 Hz, 

yielding an effective cut-off frequency of 50 Hz.  

  

The Neural Event Detector operates on the Broadband Processor, allowing the user to detect spikes, LFPs, and 

network bursts with one stream. The resulting AxIS Events .spk file contains two datasets, one with Spike times, 

locations (well and electrode), and waveforms and one with LFP times, locations (well and electrode), and 

waveforms.   
 

 

Broadband Signal 

Spike Trace (200 Hz – 5 kHz) 

LFP Trace (1 Hz – 50 Hz) LFP Detection 

Spike/Burst Detection 
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7.2. NEURAL BROADBAND ACQUISITION AND ANALYSIS TUTORIAL 

To acquire local field potentials and spikes: 

Follow the steps for data acquisition as described in Section 3.3, selecting Configuration → Neural Real-Time 

→ Broadband Spontaneous to appropriately configure the hardware and software to record broadband 

neural signals.  

Press the Record button to begin collection. 

 

To analyze local field potentials alongside spike times: 

Follow the steps for data analysis as described in Section 9.5, using Configuration → Neural Real-Time → 

Broadband Spontaneous to save a Neural Statistics Compiler Advanced Metrics .csv file. It is recommended 

here to also save an AxIS Events (.spk) file and a Broadband Processor (.raw) file for use with the Neural 

Metric Tool.   

To detect LFPs, the Neural Event Detector uses a threshold method which identifies large deflections in the low 

frequency component of the broadband signal. Since cell type, culture maturity, culture structure can all play a 

large role in the size and shape of the LFPs, Axion recommends modifying the LFP detection settings within the 

Neural Event Detector to fit each application (see Section 2.3.8). 

 

 

 

 

Spike Plots LFP Plots 

Selection for 

Threshold Source 
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Waveform Description Physiological/Noise 

 

Consistent, repetitive 

biphasic waveform. 
Physiological 

  

Consistent, repetitive 

biphasic waveform. 
Physiological 

  

Higher complexity event, 

with consistent initiation and 

multiple activity peaks.  

Physiological – more complex 

network activity, which may 

reflect increased maturation 

 

Alternation between 

biphasic waveform with 

clear peak and flat 

waveform.  

Physiological – the LFP events 

are being detected on the 

positive and negative portions.  

Considering raising the LFP 

detection threshold. 

  

Inconsistent waveforms 

without clear peaks in 

activity.  

Noise – this electrode may not 

have cell coverage or in range 

MEA viability measurement. 

 

7.3. FAQ 

1. What is a local field potential (LFP)? 

The local field potential (LFP) is the electrical potential measured in the extracellular space near one or 

more neurons.  Variation in local field potential is thought to largely be driven by a spatial summation of 
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post-synaptic potentials.  As such, the local field potential may present as discrete events coupled with 

network spiking activity or as ongoing low frequency oscillations. 

2. How is Neural Broadband mode different from Neural Spikes mode? 

The Neural Spikes mode is designed to isolate, visualize, and quantify the action potential spiking activity 

of neuronal populations.  The Neural Broadband mode retains the same biological activity from Neural 

Spikes mode, and supplements with additional information at low and high frequencies.  The Broadband 

Processor separates this information into spiking activity (200 Hz – 5 kHz) and local field potentials (1Hz 

– 50 Hz). 

3. Will I detect the same number of spikes in the Neural Broadband and Neural Spikes modes?  

The Neural Broadband modes does include additional low and high frequency content relative to Neural 

Spikes mode, which can raise the spike detection threshold.  This could result in a modest decrease in the 

number of spikes detected in Neural Broadband relative to Neural Spikes modes when the adaptive 

threshold crossing method is used for spike detection.  

4. Why do LFP shapes and amplitudes vary?  

The local field potential is believed to represent the spatial summation of post-synaptic potentials across a 

small population of neurons nearby the electrode.  As such, the shape, polarity, and amplitude of an LFP 

event will result from the involvement of the local neuronal population in the overall network activity in the 

well.  In addition, the type of neurons, and their density, can impact the shape and amplitude of an LFP.  

5. Will LFP work with poor cell coverage? 

Sufficient cell coverage over the electrodes is required to obtain a strong LFP signal.  Perhaps more 

importantly, large LFP events are typically associated with synchrony and network bursts.  Therefore, 

optimized culture conditions for LFPs should match the optimized conditions for spiking activity. 

6. Can LFP be measured from 3D neuronal models? 

Yes, LFP signals have been acquired and characterized from 3D neuronal models with the Maestro Pro 

and Edge.  The Neural Broadband mode and associated analysis further enable these applications. 

7. Is Neural Broadband compatible with all plate types? 

No. Neural Broadband mode is compatible with CytoView MEA plates, which offer low impedance 

PEDOT microelectrodes. Neural Broadband mode is not compatible with higher impedance BioCircuit 

MEA plates.   

8. Does Neural Broadband work for all cell types?  

Neural Broadband mode has been evaluated with rodent cortical neurons and commercially-available 

iPSC-derived neurons. 

9. Can I record LFP activity on the original Maestro?  

No. The Maestro Pro or Edge are required for Neural Broadband mode. 

10. Is Neural Broadband mode compatible with electrical stimulation?  

No. The standard electrical stimulation tools available in AxIS Navigator may not be used with Neural 

Broadband at this time. 

11. What is value of low frequency LFP signals in neuronal assays?   

The LFP provides an additional avenue to quantify neuronal activity.  In most cases, low frequency LFP 

signals will complement existing analysis of neuronal function via spiking activity.  In some cases, low 

frequency LFP signals will provide new information not easily detectable in spiking activity.  
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CHAPTER 8. MEA VIABILITY 

Cell structure and function are both vital to characterizing cell behavior in health and disease. With the MEA 

Viability Software Module, you can measure cell coverage and viability from the same microelectrodes used 

to characterize the electrical function of neural and cardiac networks. The MEA Viability Software Module 

uses the Maestro’s impedance technology to assess the cells over each microelectrode, providing a high-

resolution map of coverage and viability in each well. Since impedance is non-destructive and label-free, the 

measurement can be repeated many times to track changes over chronic time courses.  

8.1. MEA VIABILITY BACKGROUND  

To measure viability, a small electrical signal is delivered to the microelectrodes. How easily the signal passes 

through the cell-electrode interface to the media depends on the number of cells attached to the electrode and 

the cell membrane integrity. Thus, impedance can be used to measure cell density, coverage, and viability. 

When the electrode is uncovered, the electrical signal passes easily through to the media, and a low 

impedance value is measured. When viable cells are covering the electrode, a higher impedance is 

measured. MEA Viability is reported as the resistance at 41.5kHz, a component of impedance that is highly 

correlated with cell density and coverage. 

 

In contrast to viability assays that measure metabolic activity in cells, impedance-based MEA Viability is 

particularly sensitive to the structural integrity of the attached cell membranes, similar to traditional lactate 

dehydrogenase (LDH) and trypan blue exclusion assays1.  When the cell membrane integrity is disrupted 

(e.g., lysis, necrosis), impedance decreases as the electrical signal more easily passes through the cell-

electrode interface. Impedance may also detect early changes in cell morphology after dosing with specific 

drugs or compounds, providing users a way to predict declining cell health (see FAQ below). For some forms 

of apoptosis, the cells may initially shrink, or become pyknotic, before a disruption to membrane integrity 

occurs, thus delaying detection by MEA Viability.  

In AxIS Navigator, MEA Viability can be visualized in the Activity Map panel. In the example below, both 

viable cell coverage (left) and spiking (right) were measured from the same hiPSC-derived neurons on a 

CytoView MEA 48-well plate using the MEA Viability Module:  
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8.2. MEA VIABILITY ACQUISITION AND ANALYSIS TUTORIAL 

To acquire impedance-based MEA viability: 

1. Set up the Maestro for data acquisition as described in section 3.3. Right-click on the Maestro Pro or 

Maestro Edge stream and select Configuration to choose either a Cardiac + Viability Real-Time or 

Neural + Viability Real-Time configuration.  

 

2. Press Play or Record to begin acquiring Viability. A banner will indicate that the system is “Acquiring 

viability…” while impedance is measured. Once complete (approx. 1 minute), the banner will indicate 

“Viability successfully acquired.” The Maestro will then transition to the requested Cardiac or Neural 

acquisition settings. 

  

Note: Only Record will save the Viability data (i.e. Resistance at 41.5 kHz for each electrode) in a 

.raw file for future viewing and analysis.  

 

To skip impedance-based MEA Viability acquisition when a viability configuration is applied:  

1. Set up the Maestro for data acquisition as described in section 3.3.  

2. Right-click on the Maestro Pro or Maestro Edge stream and select Configuration to choose either a 

Cardiac + Viability Real-Time or Neural + Viability Real-Time configuration.  

3. Press Play or Record to begin acquiring Viability. A banner will indicate that the system is “Acquiring 

viability…” while impedance is measured.  
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4. Press the Skip Viability option that replaces the play controls. A banner will indicate that the system is 

“Viability is being skipped…”. The Maestro will then transition to the requested Cardiac or Neural 

analog acquisition settings. 

 

 

 

 

After acquiring Viability, resistance values in kiloohms (kΩ) can be visualized in the Activity Map by selecting 

Viability (Resistance, kΩ) in the Source drop-down above the play controls.  

 

 

 

To analyze impedance-based MEA Viability:  

1. Follow the steps for data analysis as described in Section 9.5.  

2. Right-click on the file in the Streams pane and select Configuration to apply the desired 

configuration as outlined below. See Section 9.1 for more information about analysis 

configurations. 

a. For Cardiac files, select Configuration → Field Potentials + Viability, LEAP +Viability, or 

Contractility + Viability with the option of Paced if needed.  

b. For Neural files, select Configuration → Spontaneous + Viability, Electrically Evoked + 

Viability,  Optically Evoked + Viability, Field Potentials Spontaneous + Viability, or 

Broadband Spontaneous + Viability. 

Source 
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3. Save the Statistics Compiler Advanced Metrics .csv file, which will contain both cardiac/neural and 

viability metrics, such as Resistance, Number of Covered Electrodes, and Weighted Mean Resistance.  

4. Load the .csv files from multiple time points into the AxIS Metric Plotting Tool to track changes in 

viability metrics over time.  

 

8.3. FAQ 

1. How does MEA Viability work? 

MEA Viability uses impedance technology to assess the cells covering each microelectrode. A very small 

electrical signal is delivered to the microelectrodes, and impedance measures the resistance to signal flow 

through the cell-electrode interface to the media. Impedance depends on the number of the cells attached 

to the electrode, the conformation of those cells, and the integrity of their cell membranes. Thus, 

impedance can be used to measure both cell coverage and structural integrity. MEA Viability is reported 

as Resistance at 41.5 kHz in units of kiloohms (kΩ).  

2. What is the expected range of resistance values?  

Covered electrodes are defined as electrodes with resistances greater than the Covered Electrode 

Threshold. Uncovered CytoView MEA microelectrodes in media exhibit a resistance of 8-12 kΩ. 

Following cell death, debris may leave a slightly higher uncovered resistance of 15-18 kΩ.  Users may 

adjust the Covered Electrode Threshold in the Statistics Compiler according to internal assay validation. 

3. Why does the resistance of covered electrodes vary across a well?  

The absolute resistance value may vary across electrodes due to the number of cells present on each 

electrode, their position relative to the electrode, and the strength of cell attachment.  While differences in 

resistance between electrodes can be used to distinguish covered from uncovered electrodes, MEA 

viability is most sensitive to changes over a single electrode.  When cells die, they often deteriorate and 

detach causing a reduction in resistance. Thus, changes in impedance can be used to track cell viability 

on each electrode over the course of your experiment, resolving even subtle changes (as small as 0.5%) 

in response to perturbations.  

4. Why does resistance sometimes increase within a few hours of dosing with some cytotoxic compounds? 
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An increase in resistance after dosing (2-8 hrs) is reflective of changes in cell morphology, and may be an 

early indicator of poor cell health. An increase may precede later decreases in impedance as the 

structural integrity of the membrane is disrupted by secondary necrosis or lysis.  

5. Is MEA Viability compatible with all plate types? 

No. MEA Viability is compatible with CytoView MEA plates, which offer low impedance PEDOT-coated 

microelectrodes. MEA Viability is not compatible with BioCircuit MEA plates.   

6. Does MEA Viability work for all cell types?  

MEA Viability has been evaluated with commercially available iPSC-derived cardiomyocytes and multiple 

primary and iPSC-derived neuron models. Impedance-based MEA Viability is highly sensitive to cell 

density and coverage for all cell types. Impedance is also highly sensitive to the structural integrity of cell 

membranes. For some forms of neuronal apoptosis, the cells may initially shrink or become pyknotic 

before a disruption to membrane integrity occurs, thus slightly delaying detection of cell death.  

7. Can I record MEA Viability on the original Maestro?  

No. The Maestro Pro or Edge, along with the MEA Viability Software Module, are required for MEA 

Viability. 

8. I already have a Maestro Pro/Edge.  Can I add the MEA Viability Module?  

Yes.  Your sales representative can provide additional information regarding the purchase of the MEA 

Viability Module.  For Maestro Pro or Edge systems manufactured before July 2020, a hardware 

upgrade will be required in addition to the MEA Viability Module software update.  This upgrade will be 

performed at Axion headquarters in Atlanta, GA. 

9. How does MEA Viability differ from contractility?  

Both Contractility and MEA Viability use impedance technology, but at different frequencies to enhance 

sensitivity to specific aspects of cell health and behavior. Contractility measures impedance at 3.125 kHz 

and is sensitive to movement (e.g., contraction and relaxation) of beating cells over the microelectrodes. 

MEA Viability measures resistance at 41.5 kHz, which is highly correlated with the number of viable cells 

attached to the microelectrodes.  

10. Is MEA Viability compatible with LEAP?   

MEA Viability and LEAP can be recorded in the same experiment, but not simultaneously. For best results, 

MEA Viability measurements should be made prior to LEAP induction.  

11. How does MEA viability with the Maestro platform compare to other common cell viability assays? 

Cell death is a complex process involving several potential modalities, such as apoptosis and necrosis. 

Viability assays typically measure one feature of cell death, such as reduced metabolic function, caspase 

activity, cell morphology, or plasma membrane integrity2,3. For example, resazurin (a.k.a., alamar blue) 

and MTT assays rely on mitochondrial reduction to distinguish metabolically active cells from dying cells, 

whereas trypan blue exclusion and LDH rely on membrane integrity to distinguish viable (intact) and fully 

dead (disrupted) cells. Metabolism based assays tend to indicate cell death early in the apoptotic 

process, but can be confounded by other changes in metabolism. Exclusion assays require membrane 

disruption, which often comes later in apoptotic processes in the form of post-apoptotic necrosis, but 

indicate full cell death. Impedance-based MEA Viability is most similar to trypan blue and LDH assays, as 

impedance measures the ability of intact cellular membranes to impede current flow. Unlike many label-

dependent viability assays, impedance is non-destructive and label-free. Thus, MEA Viability can be 
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repeated many times over chronic time scales for multiplexed tracking of cellular function, coverage, and 

viability. 
 

1 Orrenius, S., Nicotera, P. & Zhivotovsky, B. Cell death mechanisms and their implications in toxicology. Toxicol. Sci. 119, 3–19 (2011). 
2 Gerber, L., Melis, L. V. J., Kleef, R. G. D. M., Groot, A. & Westerink, R. H. S. Culture of Rat Primary Cortical Cells for Microelectrode Array (MEA) 

Recordings to Screen for Acute and Developmental Neurotoxicity. Curr. Protoc. 1, 1–35 (2021). 
3 Druwe, I., Freudenrich, T. M., Wallace, K., Shafer, T. J. & Mundy, W. R. Sensitivity of neuroprogenitor cells to chemical-induced apoptosis using a 

multiplexed assay suitable for high-throughput screening. Toxicology 333, 14–24 (2015). 
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CHAPTER 9. DATA ANALYSIS 

From a functional standpoint, data analysis in AxIS Navigator is similar to data acquisition. A previously 

recorded .raw file (continuous voltage data) is loaded into the Streams pane, it passes through various data 

processors, and output files are generated while AxIS Navigator “records”. Instead of recording the 

continuous voltage data from a Maestro Pro or Edge stream, file outputs from the data processors with various 

endpoint measurements are generated. This chapter reviews how to analyze data from the Maestro using 

AxIS Navigator. Sections 9.5 and 9.6 contain step-by-step tutorials for analyzing a single file and 

multiple files, respectively. 

9.1. STREAM CONFIGURATIONS 

Similar to data acquisition, AxIS Navigator comes with a variety of preset configurations for data 

analysis.  

To apply an analysis configuration: 

1. Right-click on the data stream. 

2. Select Configuration and navigate to the desired configuration. Click on the configuration. 

 

 

Analysis configurations available in AxIS Navigator include: 

Configuration Processing Applied Description 

Cardiac  

Field Potentials Cardiac Beat Detector 

Statistics Compiler 

Generates activity map, cardiac waveforms, 

beat rate, and conduction information. FPD 

detection is enabled. Generates a variety of 

cardiac beating endpoints. 

Field Potentials 

Paced 

Artifact Eliminator 

Cardiac Beat Detector 

Statistics Compiler 

Generates activity map, cardiac waveforms, 

beat rate, and conduction information. 

Optimized for reducing stimulus artifacts in 

pacing experiments. FPD detection is enabled. 
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Generates a variety of cardiac beating 

endpoints. 

LEAP Cardiac Beat Detector 

Statistics Compiler 

Generates activity map, cardiac waveforms, 

beat rate, and conduction information. 

Optimized for analyzing LEAP signals. Generates 

a variety of cardiac beating endpoints. 

LEAP Paced Artifact Eliminator 

Cardiac Beat Detector 

Statistics Compiler 

Generates activity map, cardiac waveforms, 

beat rate, and conduction information. 

Optimized for reducing stimulus artifacts in 

pacing experiments. Generates a variety of 

cardiac beating endpoints. 

Contractility Cardiac Beat Detector 

Statistics Compiler 

Generates activity map, contractility waveforms, 

beat rate, and conduction information. 

Optimized for analyzing contractility signals. 

Generates a variety of cardiac beating 

endpoints. 

Contractility 

Paced 

Artifact Eliminator 

Cardiac Beat Detector 

Statistics Compiler 

Generates activity map, contractility waveforms, 

beat rate, and conduction information. 

Optimized for reducing stimulus artifacts in 

pacing experiments. Generates a variety of 

cardiac beating endpoints. 

Neural  

Spontaneous Spike Detector 

Burst Detector 

Statistics Compiler 

Generates activity map, spike waveforms, and 

raster plot. Network burst detection is enabled. 

Generates a variety of spiking, bursting, and 

synchrony endpoints. 

Electrically 

Evoked 

Artifact Eliminator 

Spike Detector 

Burst Detector 

Statistics Compiler 

Generates activity map, spike waveforms, and 

raster plot. Optimized for reducing stimulus 

artifacts in electrically-evoked experiments. 

Network burst detection is enabled. Generates 

a variety of spiking, bursting, and synchrony 

endpoints. 

Optically Evoked  Spike Detector 

Burst Detector 

Statistics Compiler 

Generates activity map, spike waveforms, and 

raster plot. Network burst detection is enabled. 

Generates a variety of spiking, bursting, and 

synchrony endpoints. 

Field Potential 

Spontaneous 

Filter (1Hz – 200 Hz) 

Filter (200 Hz – 2 kHz) 

Spike Detector 

Burst Detector 

Generates activity map, spike waveforms, and 

raster plot. Network burst detection disabled. 

Applied filters are optimized to separate low (LFP) 

and high (spikes) frequency components of the 

signal for spike detection. 

Broadband 

Spontaneous 

Broadband Processor 

Neural Event Detector 

Generates activity map, spike and LFP 

waveforms, and raster plot. Network burst 

detection is enabled. Generates a variety of 

spiking, bursting, synchrony, and LFP endpoints. 
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Note: Configurations options will be filtered based on the Acquisition mode used to record the raw file.  

All of the Neural and Cardiac configurations can be used with the MEA Viability Software Module to allow 

users to measure impedance data and MEA data simultaneously. To learn more about the MEA Viability 

Software Module, please see Chapter 7.  

Custom analysis configurations can be designed by adding data processors to the data stream (Section 

2.3.1) or by modifying processor settings. For instructions on saving and loading custom stream 

configurations, see Section 3.2.2.  

9.2. OUTPUT FILE TYPES 

The AxIS Raw (.raw) file is the most fundamental AxIS Navigator file type; it contains the continuous 

voltage data. Any downstream processing can be recreated when the .raw file is loaded into AxIS 

Navigator. In addition to the .raw file, AxIS Navigator can generate a variety of file outputs from the 

various data processors. 

Data Processor Output Name Description 

Continuous Streams 

Maestro 

Pro/Edge 

AxIS Raw (.raw) Primary format for data acquisition. Continuous voltage 

data from all enabled electrodes before any digital 

processing. MEA Viability is also stored in the .raw file 

when requested. 

Environmental Data (.csv) Table listing temperature and CO2 concentration 

throughout the recording. 

Digital Filter AxIS Raw (.raw) Continuous voltage data from all enabled electrodes 

after the application of a Digital Filter.  

Artifact Eliminator AxIS Raw (.raw) Continuous voltage data from all enabled electrodes 

after the application of an Artifact Eliminator. 

Broadband 

Processor 

AxIS Raw (.raw) Contains two streams of continuous voltage data, one 

with high frequency spiking (200 Hz – 5 kHz) and one 

with low frequency local field potentials (1 Hz – 50 Hz). 

Playback not available in AxIS Navigator. 

Neural Events 

Spike Detector AxIS Spike (.spk) Spike times and voltage waveforms organized by 

electrode for all spikes detected by the Spike Detector. 

MEA Viability is also stored in the .spk file when 

requested. Required output file for Neural Metric Tool.  

Spike Counts (.csv) Table listing the number of spikes detected in a given time 

period for each electrode. Spike counting interval is set in 

the Spike Detector Settings. 

Spike List (.csv) Table listing time, electrode, and amplitude of all spikes 

detected by the Spike Detector. 



AxIS Navigator 3.9 User Guide 

[101]  

 

Burst Detector Electrode Burst List (.csv) Table listing the individual electrode bursts identified by 

the Burst Detector with descriptive information including 

time, electrode, number of spikes, and duration. 

Network Burst List (.csv) Table of the network bursts identified by the Burst 

Detector with descriptive information including time, well, 

number of spikes, duration, number of electrodes, and 

spikes per electrode. 

Neural Event 

Detector 

AxIS Events (.spk) 

 

Spike times, LFP times, and voltage waveforms organized 

by electrode for all spikes and LFPs detected by the 

Neural Event Detector. MEA Viability is also stored in the 

.spk file when requested. Required output file for Neural 

Metric Tool. 

Spike Counts (.csv) Table listing the number of spikes detected in a given time 

period for each electrode. Spike counting interval is set in 

the Neural Event Detector Settings. 

Spike List (.csv) Table listing time, electrode, and amplitude of all spikes 

detected by the Neural Event Detector. 

Electrode Burst List (.csv) Table listing the individual electrode bursts identified by 

the Neural Event Detector with descriptive information 

including time, electrode, number of spikes, and duration. 

Network Burst List (.csv) Table of the network bursts identified by the Neural Event 

Detector with descriptive information including time, well, 

number of spikes, duration, number of electrodes, and 

spikes per electrode. 

LFP Event List (.csv) Table listing time, electrode, and amplitude of all LFPs 

detected by the Neural Event Detector. 

Cardiac Beats 

Cardiac Beat 

Detector  

Electrode Beat List (.csv) Table of individual electrode beats and corresponding 

endpoints, which may include beat time, field potential 

spike time, electrode, depolarization amplitude, 

depolarization slope, beat period, field potential 

duration, beat amplitude, excitation-contraction delay, 

well beat number, and delay from well beat time, 

depending on the Acquisition Setting. 

Well Beat List (.csv) Table of well beats and corresponding endpoints, which 

may include well, time, number of active electrodes, 

starting electrode, ending electrode, beat period, well 

beat number, conduction velocity, maximum delay from 

well beat time, composite beat amplitude, and composite 

excitation-contraction delay, depending on the 

Acquisition Setting. 

Advanced Statistics 
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Cardiac Statistics 

Compiler  

Advanced Metrics  

(.csv) 

Primary output for data analysis. Tables containing 

group, well, and electrode endpoint metrics averaged 

over the duration of the analysis window. Depending on 

the Acquisition Setting, may include depolarization 

amplitude, slope, beat period, beating irregularity, field 

potential duration, conduction velocity metrics, beat 

amplitude, excitation-contraction delay, and viability 

metrics. Required output file for Cardiac Analysis Tool 

and/or AxIS Metric Plotting Tool. See Section 10.3 for a 

list of included endpoints. 

Neural Statistics 

Compiler 

Advanced Metrics  

(.csv) 

Primary output for data analysis. Tables containing 

group, well, and electrode endpoint metrics averaged 

over the duration of the analysis window. Depending on 

the Acquisition Setting, output metrics may include spike, 

burst, synchrony metrics, and viability metrics. Required 

output file for AxIS Metric Plotting Tool. See Section 11.4 

for a list of included endpoints. 

Note: Viability metrics are only available with the MEA Viability Software Module.  To learn more about 

the MEA Viability Software Module, please see Chapter 7.  

The Experiment Setup Properties panel defines the output file types that will be saved. Select the desired 

output from the drop-down menus in each section. More than one output may be selected from any 

drop-down menu. Any stream that should not be recorded must be set to Not Recording. Axion recommends 

saving only an AxIS Raw file from the Maestro stream during data acquisition. Generally, it is not necessary to 

save any other AxIS Raw files during acquisition nor analysis. Preset Real-Time and Offline stream 

configurations to specify the recommended output files to save. 
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To select multiple outputs from a single drop-down in Experiment Setup Properties: 

1. Select the first output from the drop-down. 

2. Click the Add button ( ). 

3. Select the next output.  

4. Repeat Steps 1-3 as needed.  

Note: To remove an output, click the Remove button ( ) or select Not Recording from the drop-

down menu.  

 

AxIS Navigator supports the use of third party software, including NeuroExplorer®, Microsoft Excel®, 

MATLAB®, Spotfire®, and any software that can import comma-separated value (.csv) data. To use these 

software packages, AxIS Navigator data must be recorded in the appropriate file types. These files will 

contain different information depending on the application. AxIS Raw files can be processed in AxIS 

Navigator, MATLAB, or NeuroExplorer. AxIS Spike files can be processed in MATLAB and 

NeuroExplorer. For NeuroExplorer, conversion to a .nex file using the Axion Data Export Tool is 

recommended to preserve platemap, stimulation, and other data and to avoid errors. Spike List, Spike 

Count, Burst List, Beat List, and Advanced Metrics files can be processed in Excel. 

9.2.1. Recorded File Names 

AxIS Navigator automatically names files based on the continuous data stream used to generate the 

output. AxIS Navigator will append a 3-digit number to the end of every file name (manually or 

Add Output File 

Inactive Stream 

Select File Type(s) 
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automatically named) to prevent identical file name conflicts. The number starts at 000 and increases by 

1 for each file recorded to the same location with the same file name. As an example: an Advanced 

Metrics file generated from a .raw file named “Compound_A.raw” will be named 

“Compound_A(000).csv”. 

Experiment properties such as date, duration, or stream source can be auto-generated in the file name 

using macros. A file name may be a mixture of macros and user entered text. For example, the file 

described above could be automatically named “Compound A_Statistics Compiler(000)” by entering 

macros [SourceFile]_[StreamName] in the file name field.  

Available macros are listed in the table below: 

Macro Description Example 

File path (example, 

C:\) 

Places the output files in the specified folder 

instead of the source file folder. Available for 

batch processing only. 

Places file in the designated 

folder 

[Barcode] The barcode of the plate used for the recording. 1166-3 

[Date] Date the output file is created (yyyymmdd). 20161210 

[Duration] Length of the output file. 1m0s 

[FileSegment] Portion of the file was analyzed. Start of File 

[Investigator] Investigator as entered in the Experiment Setup 

Properties panel. 

SC 

[Offset] Time from the start of the file processing began. 10s 

[RecordingName] Recording Name as entered in the Experiment 

Setup Properties panel. 

Experiment1 

[SourceFile] Original file name of the source .raw file. Compound_A 

[StreamName] Name of the data processor generating the 

output file. 

Statistics Compiler 

[PlateType] The name of the MEA plate used for the 

recording. 

CytoView MEA 96 

 

To manually name a file: 

1. Deselect the Auto-Name File checkbox in the Experiment Setup Properties panel. 

To add a macro to the file name: 

1. Type the macro command from the above table into the File Name field. 
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– Or – 

2. Right-click the File Name field. 

3. Select Macros and choose the macro from the menu. 

 

 

The File Name field can create folders that do not currently exist. Use ‘\’ to create new paths for output 

files. For example, the entry [SourceFile]\[StreamName] for the previous example will name the output 

file “Statistics Compiler(000).csv” and place it in a new folder called “Compound A”, created in the 

folder containing the “Compound A.raw” file. 

Note: Output files from the Broadband Processor and the Neural Event Detector default to the following 

macro structure: [SourceFile]_[StreamName]. 

9.3. PREPARING FILES FOR ANALYSIS 

Before beginning an analysis ensure all files are appropriately named and contain accurate plate maps, 

notes, and descriptions. These notes will be kept in the analysis outputs. All output files are automatically 

stored in the same folder as the .raw files so organize the .raw files in appropriate folders before beginning.  

9.4. SELECTING THE ANALYSIS WINDOW 

While performing an analysis, AxIS Navigator will stream through the continuous voltage data. AxIS 

Navigator will process the entire file or a segment of the file specified in the Stream Settings. A portion of the 

Auto-name File 

Enter File Name 

File Name Macros 
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file can be analyzed manually by starting and stopping the data stream and recording the region of interest 

using the Play, Pause, Stop, and Record buttons in the Display Controls (See Section 2.4). 

To set the analysis window automatically: 

1. Click Stop if AxIS Navigator is not already in a stopped state. 

2. Right-click the file in the Streams pane. 

3. Select Settings. 

4. Set the analysis window using the Segment Type dialog.  

Segment Type Description 

Whole File Analysis window is the entire duration of the file. 

Start of File Analysis window begins at the start of the recording 

plus the Offset and continues for the Duration. 

End of File Analysis window begins at the end of the file minus 

the Duration and continues until the end. 

 

5. Click OK. 

 

Check the Loop Playback box to automatically replay the file from the beginning when the end has been 

reached. This is useful when examining short files, but is not recommend while recording analysis files. 

9.4.1. Re-recording Segments of .raw Files 

AxIS Navigator provides a single measurement for each metric that is a mean over the entire analysis 

duration. To split a raw file into segments to obtain a time course, for example, or to archive only a portion of 

the file, it is possible to record shorter .raw files from a .raw file.  

1. Click File → Open Recording…. 

2. Select the file for analysis and click Open. 

3. Set the analysis window. See Section 9.4. 

4. Click the Experiment Setup Properties panel.  

5. Select AxIS Raw from the Maestro Pro or Maestro Edge drop-down. 

6. Optional: Uncheck Auto Name File to manually enter a file name. By default, the name will be 

[SourceFile]. See Section 9.2.1 for more information on naming output files. 

7. Click Record.  

 

To generate a time course from a single .raw file: 

Select an analysis window and run an analysis according to Section 9.5. Repeat for each analysis 

window. 



AxIS Navigator 3.9 User Guide 

[107]  

 

– Or – 

Generate new .raw files for each analysis window and run a batch process according to Section 9.6. 

 

9.5. DATA ANALYSIS TUTORIAL 

5. Click File → Open Recording…. 

6. Select the file for analysis and click Open. 

7. Prepare the file for analysis. See Section 9.3.  

8. Set the analysis window. See Section 9.4. 

9. Right-click on the file in the Streams pane and select Configuration to apply the desired 

configuration as outlined below. See Section 9.1 for more information about analysis 

configurations. 

a. For Cardiac files, select Configuration → Field Potentials, LEAP, or Contractility with the 

option of Paced or Viability if needed.  

b. For Neural files, select Configuration → Spontaneous, Electrically Evoked, Optically Evoked, 

Field Potentials Spontaneous, or Broadband Spontaneous with the option of Viability if 

needed. 

 

 

6. Click the Experiment Setup Properties panel. See Section 2.6.1 for more information on the 

Experiment Setup Properties panel.  

7. Verify Advanced Metrics is selected in the Statistics Compiler drop-down. Select any additional 

desired file outputs. It is not necessary to record the .raw data again. See Section 9.2 for more 

information on output file types. 

8. Optional: Uncheck Auto Name File beside the selected file outputs to manually enter a file name. 

By default, the name will be [SourceFile]. Auto-naming macros are available to add descriptive 

information to file names. See Section 9.2.1 for more information on naming output files. 

9. Click Play to view the data. 

10. Assess the analysis settings. See 8 for cardiac activity, 9 for neural activity.  
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11. The Accelerate Playback and Accelerate Recording options in the Tools menu play and process files 

faster than real time, respectively, for quicker analysis and can be toggled on/off, if desired. 

12. Click Record to run the analysis. 

Note: If setting the analysis window manually, start and stop the recording at the desired times. 

9.6. ANALYSIS OF MULTIPLE FILES (BATCH PROCESSING) 

It is possible to analyze multiple files sequentially using identical analysis settings with batch processing. 

In this mode analysis can be done without having to queue each file individually and wait for the 

processing to finish.  

A batch process appears as a stream in the Streams pane. The Batch Process stream acts like a 

traditional stream; analysis configurations may be applied to the batch process in the same manner as a 

single file, and all files in the batch process will be processed according to the stream configuration. 

When a batch process is the active stream, the Play button becomes a Start Batch Process button. 

 

To begin a batch process: 

1. Click File → New Batch Process…. 

2. Click Add in the Edit Batch Process Settings dialog.  

Note: Use Remove to remove any files from the Source File list. 

3. Select the desired .raw files and click Open. 

4. Select the analysis window using the Segment Type drop-down menu. See Section 9.4 for setting 

an analysis window with the Segment Type dialog. 

Batch Process 

Start Batch 

Selected Files 

Add Files 

Output Files 
Segment Type 
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Note: An orange file indicates the segment to be analyzed is longer than the total length of the 

file. Analysis will stop when the file end is reached. If the file is so short that nothing will be 

analyzed, the file entry turns red. 

5. Click OK. 

6. Right-click on the batch process in the Streams pane and select Configuration to apply the desired 

configuration as outlined below. See Section 9.1 for more information about analysis 

configurations. 

a. For Cardiac files, select Configuration → Field Potentials, LEAP, or Contractility with the 

option of Paced or Viability if needed.  

b. For Neural files, select Configuration→ Spontaneous, Electrically Evoked, Optically Evoked, 

Field Potentials Spontaneous, or Broadband Spontaneous with the option of Viability if 

needed. 

7. Click the Experiment Setup Properties panel. See Section 2.6.1 for more information on the 

Experiment Setup Properties panel.  

8. Verify Advanced Metrics is selected in the Statistics Compiler drop-down menu. Select any 

additional desired file outputs. It is not necessary to record the .raw data again. See Section 9.2 

for more information on output file types. 

Note: File names are automatically generated as [SourceFile] appended with a number starting 

with 000, and output files are saved to the same directory as each source .raw file was 

generated from. 

9. Click Start Batch Process. 

 

A white status bar will appear at the top of the active window while a batch process is running. The status 

bar will list the progress of the current file (File) and the entire batch process (Overall). 
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CHAPTER 10. CARDIAC DATA ANALYSIS 

10.1. CARDIAC ACTIVITY INTRODUCTION 

A cardiac action potential, or “beat”, consists of three phases, the depolarization, plateau, and 

repolarization. These phases are governed by the balance of ionic currents during each phase. Measured 

extracellularly on an MEA, these beats exhibit features similar to those present in an electrocardiogram 

(ECG).  

 

The initiation of a beat starts with the depolarization phase which corresponds to the QRS complex in the ECG 

and the depolarization spike in the MEA field potential recording. The T-wave in the ECG and the 

corresponding peak in the MEA field potential represent repolarization, when the voltage returns to baseline. 

For this document, the repolarization peak in an MEA will be referred to as the T-wave. A peak corresponding 

to the P-wave is not present in an MEA field potential recording. In an ECG, the P-wave represents the 

depolarization of the atria while the QRS complex and T-wave represent the depolarization and 

repolarization of the ventricles. A cardiac culture typically lacks the structural compartmentalization of an 

intact heart and only has a single depolarization and repolarization phase. 

The LEAP assay uses proprietary techniques to enhance the coupling between the cells and electrodes, 

enabling the detection of a LEAP signal which closely approximates the shape of a transmembrane action 

potential from a patch-clamp recording. See Chapter 5 for more information about LEAP. 

Under basal conditions a typical cardiac culture should beat rhythmically, with each cardiac waveform 

identical to the last. From the cardiac beat waveforms numerous metrics can be evaluated to assess beat 

rhythmicity and waveform stability. The time between depolarization spikes constitutes the beat period and 

can be used to assess the beat rate and rhythmicity.   
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The time between the depolarization and repolarization is known as the field potential duration (FPD) for field 

potential signals and LEAP duration, or action potential duration (APD) for LEAP signals. These measures 

correspond to the QT interval in an ECG. Disrupting the balance of ion channels governing the plateau and 

repolarization phases can alter the FPD/APD. Prolongation in the FPD/APD is assessed as a potential 

indicator of pro-arrhythmia.   

 

In the Maestro, contractility is measured from each electrode, providing local measurements of cardiomyocyte 

contractility in high spatial resolution across the culture. AxIS Navigator provides a contractility Beat 

Amplitude on each electrode, allowing you to track local changes in beating. In addition, well-wide 

composite contractility metrics, including Composite Beat Amplitude, Beat Period, and Excitation-Contraction 

Delay, describe the average contractility behavior across the well.  These metrics are defined in Section 10.3. 

 

The two-dimensional structure of the MEA allows cardiac signal propagation to be measured and quantified 

by comparing the depolarization timing between electrodes. In culture, cardiomyocytes form an electrically 

coupled syncytium of cells that beat synchronously. When a cardiomyocyte in that syncytium depolarizes, it 

causes neighboring cardiomyocytes to depolarize, cascading throughout the culture. In vitro cardiac beat 

conduction is analyzed by tracking the beat time across the array of electrodes and calculating the delay from 

where the beat originated.  

AxIS Navigator will classify well beats by common starting and ending locations. In 1- and 12- well plates 

(64 electrodes per well), a loosely defined nearest neighbors grid of electrodes is considered a common 

starting point; the most frequent starting electrode and any neighboring electrodes (vertically, horizontally, 

and diagonally) are considered a common starting location. For 48-well plates, a stricter nearest neighbors 

approach is used to define a common starting point; the most common starting electrode and neighboring 
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electrodes vertically and horizontally are considered a common starting location. For 96-well plates, only 

beats beginning and ending at the exact same electrode are considered common. Each beat is assigned a 

Propagation Classification ID, wherein 1 represents the most common propagation pattern detected in the 

well, 2 is the next most common, and so on.  

The figures below show four examples of propagation. The beat begins where the plot is blue (shortest delay 

from the beat origin) and ends where the plot is red (longest delay from the beat origin). The stability of beat 

propagation patterns and conduction velocity can be used to assess culture health, pacemaker stability, and 

evaluate compound effects. Slowing or disrupting beat propagation can lead to arrhythmia in vivo. 

 

 

10.2. IDENTIFYING CARDIAC DEPOLARIZATION AND REPOLARIZATION 

10.2.1. Cardiac Beat Detection 

Cardiac beat detection is based on the depolarization spike for cardiac field potentials. The Detection 

Threshold of the Cardiac Beat Detector data processor should be set lower than the depolarization spike but 

greater than any other waveform feature. Since AxIS Navigator calculates endpoints based on well beats, the 

detection threshold only needs to be accurate on some electrodes, as set by Min Active Electrodes in the 

Cardiac Beat Detector. If AxIS Navigator identifies an arrhythmia, ensure the threshold is properly set so only 

the depolarization spike, and every depolarization spike, crosses the threshold. The threshold can be viewed 

from the Continuous Waveform Plots panel as horizontal gray lines above and below the data trace for each 

electrode.  

 

Detection Threshold 



AxIS Navigator 3.9 User Guide 

[113]  

 

10.2.2.  Cardiac Field Potential T-Wave Identification 

For cardiac field potential signals, the T-wave is often much less pronounced than the depolarization spike 

and can vary considerably in size, shape, and polarity from one electrode to the next. Use the Cardiac Beat 

Plots panel to assess T-wave detection accuracy as indicated by the white whisker plot.  

Characteristics of a cardiac waveform from a synchronous cardiac culture can be represented by a subset of 

the electrodes in each well, making it possible to eliminate electrodes containing noisy or anomalous data. 

This is particularly useful for FPD measurements. T-wave locations, and therefore FPD measurements, should 

be similar between electrodes; however, physical culture differences across the well can cause some 

electrodes to display prominent T-waves and others to display none at all. For electrodes where the T-wave is 

small or absent, AxIS Navigator may generate FPD values showing high beat-to-beat variability (as indicated 

by a large FPD Confidence Interval displayed in the Cardiac Beat Plots) because of poor detection 

performance.  

Waveform Description  

 

The T-wave has been properly and consistently 

detected. It shows a very small standard 

deviation. 

Good 

Detection 

 

The trace shows no visible T- wave, therefore 

detection is unreliable, resulting in a large 

standard deviation. 

No T-wave 

Present 

 

The detection algorithm is alternately picking the 

correct T-wave and a feature earlier in the beat. 

The mean reflects the average of these two 

humps and the standard deviation is very large. 

Missed 

Detection 

 

To optimize T-wave detection: 

1. Adjust the Post Spike Detection Holdoff, Pre Spike Detection Holdoff, and Max Post Search Duration 

values. This sets the search range. If multiple peaks are present, AxIS Navigator will preferentially 

mark the first peak. Adjust the search range to bracket the preferred peak.   

2. Adjust the T-Wave Detection Feature to match the majority of T-waves. Max for upward deflecting 

peaks, Min for downward deflecting T-waves. 

3. Set the FPD Measure Quality Control settings to remove poorly detected electrodes. Arrhythmic wells 

will have low beat to beat consistency and electrode FPD consistency.  
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4. Optional: If there are many electrodes that identify the wrong peak but have a high beat to beat 

consistency, as indicated by the whisker plot, disable those electrodes.  

AxIS Navigator will assess field potential duration for all electrodes in a plate by the same criteria. When 

analyzing plates with significantly different repolarization timing across wells, it may be necessary to perform 

the analysis multiple times with settings optimized for subsets of wells with similar waveforms. For data sets with 

highly variable or hard to analyze T-waves, use the Cardiac Analysis Tool. 

10.3. CARDIAC STATISTICS COMPILER ENDPOINTS 

AxIS Navigator identifies cardiac beats with the Cardiac Beat Detector data processor (See Chapter 108 and 

Section 2.3.7). It then calculates beat rate, waveform, and conduction metrics with the Cardiac Statistics 

Compiler panel and outputs an Advanced Metrics file with the results (See Section 2.3.10). The Advanced 

Metrics endpoints are listed in the table below. 

Measurement Description 

Starting Time The start time of the analysis window. If Limit to Region of Most Stable Beat 

Period is enabled, the start time of the most stable beat period. 

Ending Time The end time of the analysis window. If Limit to Region of Most Stable Beat 

Period is enabled, the end time of the most stable beat period. 

Number of Beats Total number of well beats over the duration of the analysis. 

Starting Electrode Electrode detected first during a well beat. The starting electrode of the most 

common propagation pattern is listed in Well Averages. 

Ending Electrode Electrode detected last during a well beat. The ending electrode of the most 

common propagation pattern is listed in Well Averages. 

Propagation Consistency The number of well beats that had the most common propagation pattern 

divided by the total number of well beats. 

Total Active Electrodes The number of electrodes that detected beats. 

Total FPD Electrodes The number of electrodes remaining after FPD quality control parameters from 

the Cardiac Statistics Compiler are applied. 

Beat Period The time between successive depolarization spikes, in seconds. 

Beat Period Irregularity The coefficient of variation (standard deviation/mean) of the beat period 

multiplied by 100. 

Spike Slope The maximum change in voltage over time (dV/dt) of the depolarization spike, 

in V/s. 

Spike Amplitude1 The peak to peak (positive plus negative) amplitude of the depolarization 

spike, in mV. 

FPD2 The time from the depolarization spike to the peak of the T-wave, in ms. 



AxIS Navigator 3.9 User Guide 

[115]  

 

FPD COV2 The coefficient of variation (standard deviation/mean) of the FPD multiplied by 

100. 

Conduction Velocity Speed of depolarization spike propagation across the culture. The 

propagation delay of each electrode is plotted against its distance from the 

beat origin. A best fit line is created from these delays, and the conduction 

velocity is the reciprocal of its slope. 

2-point Conduction Velocity Speed of depolarization spike propagation across the culture.  The 2-point 

Conduction Velocity is calculated as the distance between the starting and 

ending electrode divided by the time between spike detection at the starting 

and ending electrode (i.e. Max Delay). 

Max Delay The time between depolarization spike detection at the starting and ending 

electrode. 

Beat Amplitude3 The peak to peak (positive plus negative) amplitude of the contractility beat, in 

% change in impedance from baseline. 

Excitation-Contraction 

Delay3 

The time between the depolarization spike and the peak of the contraction. 

Resistance4 Resistance is a measure of viable cell coverage over the electrode. Higher 

values indicate more intact cells are attached to the electrode. For a well, the 

average across electrodes is reported.   

Number of Covered 

Electrodes4 

Total number of covered electrodes within the well. Covered electrodes are 

defined as electrodes with resistance greater than the Covered Electrode 

Threshold defined in the Statistics Compiler settings (default 18 kOhms). 

Uncovered CytoView MEA microelectrodes in media exhibit a resistance of 8-

12 kOhms. Following neuronal cell death, debris may leave a slightly higher 

uncovered resistance of 15-18 kOhms.   

Weighted Mean Resistance4 The mean resistance across covered electrodes only (resistance greater than 

the Covered Electrode Threshold). 
1This metric is available for field potential and contractility signals only (not computed for LEAP). 
2These metrics are available for field potential signals only (not computed for LEAP or contractility). 
3These metrics are available for contractility signals only (not computed for field potentials or LEAP). 
4These metrics are only available with MEA Viability Module. 

See Sections A.2 and A.3 for additional cardiac metrics available from the Cardiac Analysis Tool and AxIS 

Metric Plotting Tool. 
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CHAPTER 11. NEURAL DATA ANALYSIS 

11.1. NEURAL ACTIVITY INTRODUCTION 

Neural cultures form intricate networks of cells that produce complex patterns of activity. A neural action 

potential consists of depolarization and repolarization phases governed by the balance of ionic currents 

during each phase. Examples of neuronal action potentials measured intracellularly and extracellularly are 

shown in the figure below.  

 

The first step to quantifying neural activity using an MEA is to identify individual neuronal action potentials or 

“spikes”. The spike shape depends upon the cells’ proximity to the electrode. Neuronal activity on an MEA is 

typically studied by quantifying the spike timing and how coordinated the spikes are across the culture. 

11.2. IDENTIFYING NEURAL SPIKES 

It is important to ensure the spikes detected are physiological. In general, physiological spikes will show a 

consistent shape that happens repeatedly, while electrical noise will not. A single electrode, however, will 

measure activity from all nearby neurons, so more than one consistent spike waveform may be present. Spikes 

can have non-standard shapes based on a neuron’s position with respect to the recording ground. Spikes 

from multiple cells can sum together to create multiple peaks.  

A quick check of the duration and amplitude of a spike can be helpful. Mammalian neurons produce action 

potential widths of approximately 1-2 ms. Any signals significantly shorter should be considered carefully. 

Amplitudes can vary greatly, but peak amplitudes typically range from 20 µV and 150 µV. Very large 

amplitudes should be reviewed skeptically. 

The following figure provides a series of examples of physiological spikes and electrical noise. These spikes 

are easiest to evaluate within the Spike Plots panel (Section 2.6.7). 

 

 

 

Gold, et al., 2006. On the Origin of the Extracellular Action Potential 

Waveform: A Modeling Study. J Neurophysiol, 95:3113-3128.

Intracellular Action Potential Extracellular Action Potential
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Waveform Description Physiological/Noise 

 

Consistent, repetitive 

monophasic waveform. 
Physiological 

  

Consistent, repetitive 

biphasic waveform. 
Physiological 

  

Multiple waveforms, but 

each waveform is consistent.  

Physiological - different neurons 

detected by the same electrode 

  

Waveforms are the same 

shape but out of phase.  

Physiological - same neuron, 

detection is near threshold 

causing different times in the 

waveform to be marked as the 

start 

  

Single occurrence. Noise 

  

The same shape in both 

positive and negative 

directions. Unstable voltage 

baseline before and after the 

spike. 

Noise 

 



Neural Data Analysis 

[118]  

 

11.3. TYPES OF NEURONAL ACTIVITY 

Beginning with continuous voltage data (top) from a single electrode, AxIS Navigator identifies neuronal 

action potentials, or “spikes”. Plotting just the spike time and location will generate a raster plot (below).   

 

 

Neuronal activity on a single electrode may be quantified in a variety of ways. Firing may be random or 

rhythmic, fast or slow, occur as single spikes or clusters. A cluster of spikes is called a burst. AxIS Navigator 

refers to bursting on a single electrode as single-electrode bursting. From a burst, additional parameters may 

be quantified such as burst frequency and duration. 

 

Having multiple electrodes in an array recording allows examination of network-wide coordinated activity. A 

network burst is a coordinated cluster of spiking across multiple electrodes. The distance between two 

electrodes is such that no two electrodes will detect firing from the same neuron. Coordinated activity such as 

a network burst therefore represents synaptic communication between neurons.  

 

10 s 

1
0

0
 

V
 

10 s 
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The level of coordinated or simultaneous spiking between electrodes is referred to as the culture’s synchrony. 

Synchrony between two electrodes may be quantified using a cross-correlogram. The cross-correlogram 

assesses the probability of a spike occurring on electrode A at times relative to a spike on electrode B. This 

probability is summed across all spikes in electrode B to produce the cross-correlogram. For example, if both 

electrodes always fire together, the cross-correlogram would have a sharp peak at time 0. 

Measuring the area under the cross-correlogram around zero is an effective way to quantify synchrony. A 

short synchrony window (e.g. 5 ms) quantifies synchrony on a millisecond timescale, while a long synchrony 

window (e.g. 50 ms) captures synchronous activity on slower timescales. 

AxIS Navigator uses frequency domain methods (Halliday, Rosenber, Breeze & Conway 2006) to compute 

and pool the cross-correlogram across all unique pair-wise combinations of electrodes in a well. A 

normalized pooled cross-correlogram is generated by removing autocorrelations, each electrode’s cross-

correlation with itself. An example of a pooled cross-correlogram is given below. When spiking occurs at 

similar times between all electrodes, synchrony is high. 

 

 

 

While spikes represent a direct measure of neural activity, LFPs are an indirect measure of activity. In 

monolayer neural cultures, noticeable LFP events tend to be phase-locked with network bursting, and higher 

levels of synchrony within bursts tend to result in larger LFPs. In addition, quantifying features of the LFP shape 

such as amplitude and duration, a common method of analyzing LFPs is to take the power spectral density and 

compute the relative power of the signal in different frequency bands. 
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11.4. NEURAL STATISTICS COMPILER ENDPOINTS 

AxIS Navigator identifies spikes and bursting with the Spike Detector and Burst Detector or the Neural Event 

Detector data processors (See Sections 2.3.5 and 2.3.6). It then calculates spiking, bursting, and synchrony 

metrics with the Neural Statistics Compiler panel and outputs an Advanced Metrics file with the results (See 

Section 2.3.11). The activity can be broadly grouped into four categories: spiking, single-electrode bursting, 

network bursting, and synchrony. The Advanced Metrics endpoints are listed in the table below. 

 

Measurement Description 

Spiking  

Number of Spikes Total number of spikes over the duration of the analysis. 

Mean Firing Rate Total number of spikes divided by the duration of the analysis, in Hz. 

ISI Coefficient of Variation The coefficient of variation (standard deviation/mean) of the inter-

spike interval, the time between spikes. This is a measure of spike 

regularity. 

Network ISI Coefficient of Variation Coefficient of variation (standard deviation/mean) of the inter-spike 

interval for all spikes on all electrodes in a well. This is a measure of 

spike regularity across the network. This metric captures the distribution 

of spiking such that 0 indicates spikes perfectly distributed and > 1 

indicates network bursting. 

Number of Active Electrodes Number of electrodes with activity greater than the minimum spike rate 

set in the Neural Statistics Compiler. 

Weighted Mean Firing Rate The mean firing rate based on only electrodes with activity greater 

than minimum spike rate set by the Neural Statistics Compiler. 

Single-Electrode Bursting  

Number of Bursts Total number of single-electrode bursts over the duration of the 

analysis. 

Number of Bursting Electrodes Total number of electrodes in the well with single-electrode bursts. 

Burst Duration Average time from the first spike to last spike in a single-electrode 

burst. 

Number of Spikes per Burst Average number of spikes in a single-electrode burst. 

Mean ISI within Burst Average inter-spike interval, time between spikes, for spikes in a 

single-electrode burst. This is a measure of burst intensity; smaller 

values mean more intense bursts. 

Median ISI within Burst Median inter-spike interval, time between spikes, for spikes in a single-

electrode burst. 

Inter-Burst Interval Average time between the start of single-electrode bursts. 

Burst Frequency Total number of single-electrode bursts divided by the duration of the 

analysis, in Hz. 
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Normalized Duration IQR Interquartile range of single-electrode burst durations. This metric 

provides a measure of single-electrode burst duration regularity. If the 

middle 50% of single-electrode bursts are approximately the same 

duration, this value will be small, whereas, if the single-electrode 

bursts vary widely in duration, this range will be large. 

IBI Coefficient of Variation The coefficient of variation (standard deviation/mean) of the inter-

burst interval, the time between single-electrode bursts. This is a 

measure of single-electrode burst regularity. 

Burst Percentage The number of spikes in single-electrode bursts divided by the total 

number of spikes, multiplied by 100. 

Network Bursting  

Number of Network Bursts Total number of network bursts over the duration of the analysis. 

Network Burst Frequency Total number of network bursts divided by the duration of the analysis, 

in Hz. 

Network Burst Duration Average time from the first spike to last spike in a network burst. 

Number of Spikes per Network 

Burst 

Average number of spikes in a network burst. 

Number of Electrodes Participating 

in a Burst 

Average number of electrodes with activity during a network burst.  

Number of Spikes per Network 

Burst per Channel 

Average number of spikes per burst divided by the number of 

electrodes participating in that burst.  

Network Burst Percentage The number of spikes in network bursts divided by the total number of 

spikes, multiplied by 100. 

Network IBI Coefficient of Variation The coefficient of variation (standard deviation/average) for the inter-

network burst interval, the time between network bursts. This is a 

measure of network burst regularity. 

Network Normalized Duration IQR Interquartile range of network burst durations. This metric provides a 

measure of network burst duration regularity. If the middle 50% of 

network bursts are approximately the same duration, this value will be 

small, whereas, if the network bursts vary widely in duration, this 

range will be large. 

Synchrony  

Area Under Normalized Cross-

Correlation 

Area under the well-wide pooled inter-electrode cross-correlation 

normalized to the auto-correlations. Higher areas indicate greater 

synchrony.  

Area Under Cross-Correlation Area under the well-wide pooled inter-electrode cross-correlation.  

Full Width at Half Height of Cross-

Correlation 

Distance along the x-axis (phase lag) from left half height to right half 

height (probability) of the cross-correlogram. Higher full widths 

indicate a wider correlogram (less synchrony) whereas lower full 

widths indicate a taller correlogram (greater synchrony). 
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Synchrony Index A unitless measure of synchrony between 0 and 1 (Paiva et al 2010). 

Values closer to 1 indicate higher synchrony. 

Viability  

Resistance1 Resistance is a measure of viable cell coverage over the electrode. 

Higher values indicate more intact cells are attached to the electrode. 

For a well, the average across electrodes is reported.   

Number of Covered Electrodes1 Total number of covered electrodes within the well. Covered 

electrodes are defined as electrodes with resistance greater than the 

Covered Electrode Threshold defined in the Statistics Compiler 

settings. Uncovered CytoView MEA microelectrodes in media exhibit 

a resistance of 8-12 kOhms. Following neuronal cell death, debris 

may leave a slightly higher uncovered resistance of 15-18 kOhms.   

Weighted Mean Resistance1 The mean resistance across covered electrodes only (resistance 

greater than the Covered Electrode Threshold). 

LFPs  

Number of LFPs2 Total number of LFPs detected across all electrodes in a well. 

Number of LFPs per electrode2 Mean number of LFPs per electrode in each well. Standard deviation 

also reported. 

LFP Rate2 For each well, reports the mean and standard deviation of the rate of 

LFP occurrence in Hz. 

Amplitude2 For each well, reports the mean and standard deviation of the peak-

to-peak amplitude of detected LFPs in µV. 
1These metrics are only available with MEA Viability Module. 
2These metrics are only available from a Statistics Compiler which has been attached to a Neural Event 

Detector 

 

See Section A.1 for additional neural metrics available from the Neural Metric Tool. 
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APPENDIX A. AXION STANDALONE TOOLS 

Axion provides a number of standalone analysis tools that enable data post-processing and visualization. 

Providing these tools independent of AxIS Navigator allows Axion to rapidly respond to customer requests 

and provide additional features that are not within the scope of the existing AxIS Navigator software. These 

tools use the MATLAB Compiler Runtime package (MCR), which is automatically downloaded during the 

installation process. 

The Axion Standalone tools will be preinstalled on the Maestro computer and can be accessed from the icons 

on the desktop. The files required to re-install or upgrade the Axion Standalone tools can be downloaded 

from Axion’s download site at https://axionbiosystems.sharefile.com. Access to this site requires a log in and 

password. This should have been provided when the Maestro was purchased. For account information, email 

support@axionbio.com. Log in to the download site and navigate to the Software folder to find the standalone 

tool installation files. 

Download the executable installation file for the desired tool. Double-click this file to begin installation and 

follow the onscreen instructions. Most standalone tools work using the MATLAB Compiler Runtime program. 

The installer will detect if the correct version of MCR is present on the computer and will download and install 

the correct version, as needed. When the installation is complete, the standalone tool will appear in the start 

menu and, if selected during installation, a shortcut will appear on the desktop. 

To install the tool on a computer that does not have internet access, contact support@axionbio.com. 

A.1. NEURAL METRIC TOOL 

The Neural Metric Tool calculates bursting and synchrony metrics, similar to those computed by AxIS 

Navigator, along with additional metrics. It also offers advanced algorithms for burst detection, stimulation-

evoked activity analysis, an LFP visualization tool with an additional method for extracting LFPs, and generates 

plate map visualizations, raster plots, and synchrony cross-correlograms not available in AxIS Navigator. See 

Chapter 11 for a detailed description of spiking, bursting, synchrony, and network bursting.  

Note: Files generated by NETRI NeuroFluidicsTM MEA plates are not supported in the Neural Metric Tool. 

A.2. CARDIAC ANALYSIS TOOL 

The Cardiac Analysis Tool (previously CiPA Analysis Tool) is a comprehensive cardiac analysis software 

designed for any cardiac application requiring precise assessment of field potential duration (FPD) and 

arrhythmia. The Cardiac Analysis Tool also analyzes LEAP signals for automated arrhythmia detection and 

classification and generation of LEAP endpoints (including APD90). The tool automatically generates a PDF 

report containing experimental results for field potentials and LEAP.  

A.3. AXIS METRIC PLOTTING TOOL 

The AxIS Metric Plotting Tool allows rapid visualization of experiment results and organization of endpoints 

according to treatment condition. This tool imports all endpoints generated by AxIS Navigator, along with a 

mailto:port@axionbio.com
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plate map, and calculates % change relative to baseline for each well, averages replicates, and generates 

plots comparing treatment conditions or time points. The tool allows for viewing of different endpoints with a 

single click, facilitating data exploration. For neural files, the tool automatically generates a PDF report 

containing experiment results. In addition to these, the AxIS Metric Plotting Tool analyzes contractility raw 

signals for beat detection and generation of additional endpoints, such as Beat Width and Composite Beat 

Amplitude. 

A.4. AXION DATA EXPORT TOOL 

The Axion Data Export Tool is used to export .raw data into a .csv file, and convert .spk files into .nex files 

for use with 3rd party software.  


